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cxReveal User Manual

The IBM Tealeaf cxReveal User Manual describes how to use IBM Tealeaf cxReveal
to search, review, and replay visitor sessions through the Tealeaf Portal. Use the
following links to access specific topics in the manual.

© Copyright IBM Corp. 1999, 2014 v



Vi  IBM Tealeaf cxReveal: cxReveal User Manual



Chapter 1. cxReveal Overview

IBM Tealeaf cxReveal enables support representatives in the call center to rapidly
search for, retrieve, and replay customer sessions to enhance customer issue
troubleshooting and improve overall customer experience.

Note: IBM Tealeaf cxReveal is licensed to support up to five search fields for each
type of search (Active Session, Closed Sessions, All Sessions), excluding the
following search fields: All Text, Text in Response or Text in Request. This limit
applies to the IBM Tealeaf cxReveal capability provided natively through the
Tealeaf Portal or to searches run through the IBM Tealeaf cxReveal API.

IBM Tealeaf cxReveal is accessed through the Tealeaf Portal and runs entirely
within your web browser. It requires no additional software installation.

Search Configure Help

{GMT-7} [C5R: Logout

| Search Onfine lseky

Template: <Defaul Cormplsted= This will ssarch across avalable Completed sessions,

Search Range: | Only Today = | Available Dates: 05/12/Z000 00:00 - O5/19/2010 16:16

Bagic Saarch Fisdds Search Scope: | AND - Sames Session &

all Text

Tt i Reguest All Text X
Tk in Response Al Text [includes =1
Everits

Event Valuss

Seszion [nfo
Pags info ogint0________ X
Login 10 [ mcludes =

Figure 1. Searching with IBM Tealeaf cxReveal

Search

IBM Tealeaf cxReveal provides two methods of searching for sessions:

1. Database Search: As soon as Tealeaf detects a new session, it is accessible for
search through the IBM Tealeaf cxReveal database. Based on session attributes,
such as the user login identifier, which is defined by Tealeaf users, you can
search for individual sessions as soon as they are detected by Tealeaf.

Note: Tealeaf recommends using the Search database for more immediate and
more efficient searches for sessions. Searching for sessions through the Tealeaf
Canisters must be reserved for generalized searches that cannot be easily
satisfied by session attribute search.

¢ See Chapter 5, “cxReveal - Searching Sessions by Session Attribute,” on page
33.

© Copyright IBM Corp. 1999, 2014 1



2. Canister Search: IBM Tealeaf cxReveal users can be enabled to complete session
searches against the Tealeaf Canisters. This search method is most useful for
exploratory searches.

* When you search for sessions, you specify the search through a search
template, modify search options and fields, and then run the search. See
Chapter 4, “cxReveal - Searching for Sessions,” on page 15.

 After you run a search, IBM Tealeaf cxReveal provides several methods for
analyzing search results and finding the appropriate search sessions. See
“Search Results” on page 25.

Both search methods are accessed through the Tealeaf Portal.

Replay
If you find a session that you would like to see as it occurred during the visitor
experience, you can replay the session through your web browser.
* See "CX Browser Based Replay" in the IBM Tealeaf cxImpact User Manual.

Tealeaf also provides a standalone desktop application for finding and reviewing
sessions, which may be installed on your desktop.

* For more information, see the "RealiTea Viewer (RTV) User Manual" in the IBM
Tealeaf RealiTea Viewer User Manual.

cxReveal Features

For more information about the Portal features enabled with IBM Tealeaf cxReveal,
see "Portal Navigation" in the IBM Tealeaf cxImpact User Manual.

Next Steps

To get started, explore the IBM Tealeaf cxReveal Quick Start Guide, which includes
simple steps for finding sessions.

* See Chapter 2, “cxReveal - Quick Start Guide,” on page 3.

2 IBM Tealeaf cxReveal: cxReveal User Manual



Chapter 2. cxReveal - Quick Start Guide

To get started with IBM Tealeaf cxReveal, you can review the following sections,
which provide an overview.

Install

Note: The ability to search by session attribute requires a separate installation and
configuration of the Windows pipeline to capture these attributes and the IBM
Tealeaf cxReveal database in which to store them.

* See "cxReveal Installation” in the IBM Tealeaf cxReveal Administration Manual.

* See "Configuring Session Attribute Search" in the IBM Tealeaf cxReveal
Administration Manual.

Login

To access IBM Tealeaf cxReveal, you must log in to the Tealeaf Portal by using
your IBM Tealeaf cxReveal account. In the address bar of your browser, enter the
URL to the Portal login page.

* After you log in, IBM Tealeaf cxReveal commands are available through the
Search menu.

Note: If you do not know the login to access the Tealeaf Portal, contact your
Tealeaf administrator.

Username!
Fassword:

Note: Your user account might or might not require a menu bar. Tealeaf
administrators can configure access to the Portal menu bar as needed. See
"cxReveal User Administration" in the IBM Tealeaf cxReveal Administration Manual.

Session Search

© Copyright IBM Corp. 1999, 2014

Through IBM Tealeaf cxReveal, you can search active and completed sessions.

* An active session is a visitor experience with the web application that is still
on-going. You can monitor visitors while they are browsing the web application.

* A completed session is a session that the visitor is no longer experiencing. The
visitor has either left the web application or has otherwise interrupted activity
for a sufficient length of time.

* You can also complete a search of both active and completed sessions by using a
All Sessions search template.

Note: IBM Tealeaf cxReveal is licensed to support up to five search fields for each
type of search (Active Session, Closed Sessions, All Sessions), excluding the
following search fields: All Text, Text in Response or Text in Request. This limit
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applies to the IBM Tealeaf cxReveal capability provided natively through the
Tealeaf Portal or to searches run through the IBM Tealeaf cxReveal API.

To begin searching sessions, select Search in the Portal menu. Then, select the type
of session for which to search. See Chapter 4, “cxReveal - Searching for Sessions,”
on page 15.

Active Session Search

m m m‘ T T

Template: <Dafault Active This will search across available Active sessions,

Basic Search Fislds ESearch Scope! iAND - Same Session -E
Session [nfo
Text in Response
Sessmn Index . T
o B Test in Response [mcludes =] [plesser
Login I Login 10 x
User IDv
ke Logn 10 [includes =l [robody@tealeat.com
chgrt IP
Browsar Type
e Liiiuaa]
First Page
Last Page
Intaresting Sessons
Page Irifo

Session Attribute Search

IBM Tealeaf cxReveal also supports the ability to search for sessions as soon as

they are detected by Tealeaf by using a preconfigured set of session attributes as
your search terms.

Using a search template of IBM Tealeaf cxReveal type, you can specify values for

session attributes, such as the visitor's login ID, on which to search for their
sessions.

Note: Searching for session attributes requires the installation of the IBM Tealeaf
cxReveal database and additional configuration. See "Configuring Session Attribute
Search" in the IBM Tealeaf cxReveal Administration Manual.

For more information about defining searches by using session attributes, see
Chapter 5, “cxReveal - Searching Sessions by Session Attribute,” on page 33.

* Depending on your web application and how Tealeaf is configured to monitor it,
these session attributes can be defined by Tealeaf event at any time during the
session. For more information, contact your Tealeaf administrator.

IBM Tealeaf cxReveal: cxReveal User Manual



cxReveal - Sessions List

After you run your search, the list of matching sessions is displayed in the Sessions
List.

* To replay a session, click the Camera icon in the same row.

All Sessions Search ¥ Session List

Bispbaying 100 of 153 matching sessions Displayed Time Zones (GMT-08:003 Pacfic Tims {US & Canada)
== Session List Template: [<Default- =]
B Achve SesE0n
prag Column Headers Here To Groop
o BFP [ 05082010 12:20:07 00:09:08 LT L, b
o B 05082000 12:18:10 O002:28 TR R AR 21

8P & osszoi012114:28 0010000 R AR, O 1
B § os/usz010 12002057 00i00:0L TR T, O 1
B L 050572010 11:58:10 00:00:11 T, T W ¢ R 4
B 05/05/2000 11:55:23 0D:03:18 R, R W A 1z
Wi O5/5/2010 11:48:18 00 00:03 T AR, AR 2
el O5/B5/2000 11:40:39  O0:00:59 TR, W T AT ]
LTS OS/DE/Z000 11:30:06  00:00:08 TR, WA W T 5
B I 05052000 11:32:56 00:00:00 R O 1
WP E 0502010 1132024 000007 Y, O A
WP I 05052010 11:22:38 00104505 A P | P e 15
WP L 05052000 11:16:29 00i03:13 L PR T PR AN 5

— See "CX Browser Based Replay" in the IBM Tealeaf cxImpact User Manual.
* To see session information, click the I icon in the same row.

All Sessions Search ¥ Session List

Displaying 100 of 153 matching sessions Displayed Time Zone: (GMT-08:00) Pacfic Tima (US & Canada)
== Session List Template: [ <Defaults 2
O Active Session
- s CANISTER dbetlS5K_Z0100505_SIERRA dat
o BFL 05052000 12:20:37 Ksassion Tndex 167474 2
o &I osvs2001zi18:00 (P Address A A 21
W d os/ms/2010 121420 :::i':r B :“;: . G i
WL oss2m0 a0z %m:w 547,745 A, EE 1
WP L 05052000 11:58:10 [T 4
W £ 0505/2040 11:55:23 Ao b iz
Wil 05/05/2010 11:48-18 00;00-03 E SR Shekibidsd ] z
Mol O5/D5/2040 11:40:39 00:00:30 R W W T 9
B I 05052000 1139006 00:00:06 L P T 5
B I 05052010 1092056 00:00:00 Bk ook ok ok ol ok oo 1
B I 05/0S/2010 11:32:84 00:00:07 ) H
WP § 050572010 1122058 00i04:05 R R ] i5
WP 05052010 11:16:29 00:03:13 Rl B R Ll 9

Event information is displayed as a series of icons in the Events column. To get
more information about the event, move the mouse over it.

See “Search Results” on page 25.

cxReveal - Replay

You can replay sessions through your browser. In Browser-Based Replay, you can
use the Navigation pane on the left side of the screen to select individual pages.

When a page is selected from the list:
* The triggered events on the page are displayed in the Events pane.

¢ The names and values of the form fields in the page are displayed in the Form
Fields pane. Form field values are highlighted in the main window.

¢ The page itself is displayed in the main window.

Chapter 2. cxReveal - Quick Start Guide 5
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Title Time Stam Browser Major Version; Traffes Type; BROWS:

] ] .Horn- page 0807 2012 1 Search enlite atore e
»rEs Customer Login 08/07/2012 1
(3= [ My Actount 8072012 1
rE7 Strauss ard Plas 08/07/2012 3
» B8 Addrsgs Book  DEMTE012 1
rEs Edit Address 08702 1
b Fat nddeess Book 087012 1|

F12 Edit Address 0870772012 1|

[~ Evant Qcourrences in Session: 3

I valus[Numeric]: 617393

&4 ReportGroup: URLAChannsl
52 FactHummeric]: 617383

URL (Normalizad): TLT§OT P ‘-\;'
M Event: Evant1 Buy Canon KEBEL i FREE SHIPPING on orders over $50.
|- Event Dceurrances in Session: 3 't e ThimoMeris vald on all our siore derma

L valus[Wumers]: 0 Starting at 5499
=™ Event: Page Round Trip by Shann_|
|- Event dcourrences in Session: &

 Nalus[Numerc]: SE7
=3 RepartGraup: URL/Charms!
=3 FackHurmeric]: 557

Best Selling Products

* See "CX Browser Based Replay" in the IBM Tealeaf cxImpact User Manual.

BBR commands
The following commands can be used to increase ease of use for Browser Based

Replay:

Command
Description

Refresh icon
Refresh the contents of the list of pages (active sessions only).

Page List icon
Toggle display of the list of pages for the session.

Hide Hide the left panes.

Options drop-down
Select display and other options in the submenus. See "BBR Options" in the
IBM Tealeaf cxImpact User Manual.

Start Replay
Start replay of the session from the current page.

Previous
Step to the previous page in the session.

Next Step to the next page in the session.

Request
Display request view. See "Browser Based Replay Interface" in the IBM
Tealeaf cxImpact User Manual.

Replay
Display replay view. See "Browser Based Replay Interface" in the IBM
Tealeaf cxImpact User Manual.

IBM Tealeaf cxReveal: cxReveal User Manual



Response
Display response view. See "Browser Based Replay Interface" in the IBM
Tealeaf cxImpact User Manual.

Overlays drop-down
Select a IBM Tealeaf cxOverstat overlay to display.

Note: This menu is available only if IBM Tealeaf cxOverstat is licensed. See
"exOverstat User Manual” in the IBM Tealeaf cxOverstat User Manual.

Annotations icon
Click to add annotations to the page. Button is highlighted if the current
page contains annotations.

Close icon
Close the session replay.

* See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User Manual.

Reference

For more information about replay, see "CX Browser Based Replay" in the IBM
Tealeaf cxImpact User Manual.

* For more information about monitoring active sessions through replay, see
"Tracking Interactions through BBR" in the IBM Tealeaf cxImpact User Manual.

Chapter 2. cxReveal - Quick Start Guide 7
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Chapter 3. cxReveal Overview dashboard

The IBM Tealeaf cxReveal Overview dashboard provides a top-down perspective
on search metrics and other activities of IBM Tealeaf cxReveal users, and also
summary view of the overall health of your site.

e To access the dashboard, select Dashboards > IBM Tealeaf cxReveal Overview
in the Portal menu.

Note: This dashboard is available in read-only format to all Tealeaf licensees of the
IBM Tealeaf cxReveal product. Configuring the dashboard requires the IBM Tealeaf
cxView license. See “Configuring the Dashboard” on page 14.

Using the Dashboard

In the dashboard, you can see individual dashboard components.

cxuBeveasl Overview - 11 /0972010

E—— E=3

Ligngs Madrics Suirimary - Teday

1Mmazn o
0,000 O cxRwsnnl Admin
B cxReves Uses
15,000+
E 10,2001
]
51000 4
o T T
o ik Qa:ulnbﬂ; Sichad
wally Rasidiz Pl i wilhoul Fagiits

W 5 npup

Lizage Matncs By User - Today

arches Sessiuns search !-evlrl:h Replay Last
Iullh It‘pll':nll !Entﬂwm“ iy Use = !-uln'd'l l.:-lnr
ﬂ I:li

11052010 1L/0S/2010 1L"Erg.l'2|3=l[|

IE'I'EALADM[N 2 !5 '555 lEIIII.EIIII LL/M%Z010 11/05/2010 11/09/2020

Figure 2. IBM Tealeaf cxReveal Overview Dashboard

e “Usage Summary Tab” on page 10 - Provides summary information about user
activities, such as searches, returned results, and replays. See “Usage Summary
Tab” on page 10.

On the displayed dashboard, you can access controls to switch the dashboard,
email a snapshot of it, or open it in a remote window. For individual dashboard
components, you can refresh the data, view the detail report from which the data
originated and, if you have the appropriate permissions, edit the dashboard
component.

¢ See "Using Dashboards" in the IBM Tealeaf cxView User Manual.

* For more information about editing dashboard components, see "Configuring
Dashboards" in the IBM Tealeaf cxView User Manual.

© Copyright IBM Corp. 1999, 2014 9



Usage Summary Tab

The Usage Summary tab provides summary information about user activities, such
as searches, returned results, and replays.

Usage Metrics Summary - Today

This chart summarizes by IBM Tealeaf cxReveal user group the counts of searches
with and without positive results, sessions that are returned, and sessions that are
replayed of those returned sessions for today.

Details on each metric are displayed in the components below this chart.
* See “User Searches” on page 11.
* See “Sessions Replayed” on page 12.

Upage Matrics Surnmary - Tades

pREL ]
20,000

B cxfaveal Admman
B cofeven Lisaer

5,000 4

E 10,000 4
i1

5,000 +

a T v T
Searches Sesslons SEsmions Searches
waiih Fesuts Returned Repdayed without Rasults
U Groug

Figure 3. Usage Metrics Summary

Usage Metrics by User - Today

By individual user, you can review counts and computations of IBM Tealeaf
cxReveal usage metrics, and also the user's most recent activities.

Usage Metrice By Liger - Today

A E Q9

|
LCELTIE Soarch fwarch Replay
Beployed | EMectiveness % Efficiency % | Use %

LC5R & d B01z 3 LU T .05 7500 2 1LA09/2010 11708/20010. 11/0%/2000
REVEALADMIN s e 15,555 2 100,00 .01 100,00 o 11092010 3110972010 $10972000

Figure 4. Usage Metrics by User

Field Description
User The IBM Tealeaf cxReveal user.

Searches
Number of searches run today. See “User Searches” on page 11.

Searches with Results
Number of searches today that returned a positive number of results.

10 IBM Tealeaf cxReveal: cxReveal User Manual



Sessions Returned
Total number of sessions that are returned in today's searches. See
"Monitoring User Activity" in the IBM Tealeaf cxImpact Administration
Manual.

Sessions Replayed
Total number of sessions that are replayed from returned searches. See
“Sessions Replayed” on page 12.

Search Effectiveness %
Search effectiveness is computed as the number of sessions that are
returned per run search for the user. See “Search Effectiveness” on page 12.

Search Efficiency %
Search efficiency computes how efficiency is the user in returning the
minimum number of results per search. See "Monitoring User Activity" in
the IBM Tealeaf cxImpact Administration Manual.

Replay Use %
This metric computes the number of replays that are run per search. See
“Replay Use” on page 13.

Searches without Results

Number of searches that are run by the user that did not return a positive
number of results.

Last Login
Timestamp of last login for the user.

Last Search
Timestamp of last search for the user.

Last Replay
Timestamp of last replay for the user.

User Searches

Over the preceding four weeks, you can review the number of searches that are
run by each IBM Tealeaf cxReveal user group.

* To see the report data, click the View Report Data icon in the corner of the
dashboard component. For more information about this report, see "Monitoring
User Activity" in the IBM Tealeaf cxImpact Administration Manual.

Chapter 3. cxReveal Overview dashboard 11
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= cxReveal Admin
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Figure 5. User Searches

Search Effectiveness

The Search Effectiveness component charts the effectiveness of searches each day

over the preceding four weeks by each IBM Tealeaf cxReveal user group.

* To see the report data, click the View Report Data icon in the corner of the

dashboard component. For more information about this report, see "Monitoring

User Activity" in the IBM Tealeaf cxImpact Administration Manual.

=3

0%

110952010

0%+
L 0%
E 0%
E 0%
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0% 4+——

LI UL
aa:00 04:00 0300

Time

I
1200 16:00

T 1
20:00

— cxReveal &dmin
= cxReveal Uzer

Figure 6. Search Effectiveness

Sessions Replayed

This component indicates the number of daily sessions that are replayed by each

IBM Tealeaf cxReveal user group over the preceding four weeks.
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* To see the report data, click the View Report Data icon in the corner of the
dashboard component. For more information about this report, see "Monitoring
User Activity" in the IBM Tealeaf cxImpact Administration Manual.

10132010 - 1170952010
4 = cxReveal Admin
= cxReveal Uszer
e |
E
E 2 1
[
1 1 -
l:l 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 I I I I I I I I
104352010 102002010 1082752010 1100352010
Time

Figure 7. Sessions Replayed

Replay Use
This percentage chart indicates the replays that are run per session as a percentage
for each day over the preceding four weeks for each IBM Tealeaf cxReveal user
group.
* To see the report data, click the View Report Data icon in the corner of the

dashboard component. For more information about this report, see "Monitoring
User Activity" in the IBM Tealeaf cxImpact Administration Manual.

Feplay Use

101372010 - 11/0952010

120% = cxReveal Admin

100% . T cxReveal Uzer

a9
BO0%

Percentage
™

40%% H
2055 H

l:l':-:{:' I LI 1 I LI I 1
1032010 1052002010

1 1 I 1 1 1 1 1 I
102752010 11032010
Time

Figure 8. Replay Use
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User Inactivity for Annotations - Today

Annotations can be added to individual active and completed sessions as a useful
mechanism for tracking customer service workflows. This report identifies the
most recent annotation events (add, edit, or delete) for individual IBM Tealeaf
cxReveal users during the day.

User Inachyity for 'Annotations’' - Today

m Last Event Dccurrence Last Portal Activity

CER /A 11/09/2010
REVEALADMIN N/ 11/09/2010

Figure 9. User Inactivity for Annotations - Today

Field Description

Username
The IBM Tealeaf cxReveal user.

Last Event Occurrence
Timestamp of when the user last added, edited, or removed an annotation.

Last Portal Activity
Timestamp of when the user last used the Portal.

Configuring the Dashboard

If you license IBM Tealeaf cxView, you can configure the components that are
displayed in the dashboard.

* See "Configuring Dashboards" in the IBM Tealeaf cxView User Manual.

14 1BM Tealeaf cxReveal: cxReveal User Manual



Chapter 4. cxReveal - Searching for Sessions

You can access IBM Tealeaf cxReveal search facilities through the Search menu in
the Tealeaf Portal.

Depending on the type of search you want to make, make your selection in the
Search menu and configure the displayed options before you run the search.

Note: IBM Tealeaf cxReveal is licensed to support up to five search fields for each
type of search (Active Session, Closed Sessions, All Sessions), excluding the
following search fields: All Text, Text in Response or Text in Request. This limit
applies to the IBM Tealeaf cxReveal capability provided natively through the
Tealeaf Portal or to searches run through the IBM Tealeaf cxReveal API.

* “Selecting and modifying search options”
* “Building and submitting a search” on page 21
* “Search Results” on page 25

Selecting and modifying search options

On the Portal search page, you can specify the search terms to find the sessions for
which you are looking and apply various search options to narrow the range of
potential results.

Depending on data volume and system performance, search can be a
resource-intensive process, so by using the available search tools to refine your
search terms as much as possible generates better quality results with a fewer
number of sessions in the returned list.

* After you specify a search, you can save the search for later use. When you load
a search, you can specify different criteria and change the generated results.

Search template

When you begin a search, you can specify your search criteria, which are available
to you through a search template.

A search template contains a predefined set of fields and initial values to help you to
create better search results that are based on your Tealeaf solution and its data.

The name of the currently selected template is displayed as a hyperlink just below
the toolbar.

Search template types

There are three types of search templates available depending upon the type of
search you choose to conduct.

Search templates are defined and organized according to the type of search you are

running:

* Active: For searches of active sessions, the available templates are listed under
the Active heading. Since active sessions have not been indexed yet, the
available search fields are typically a subset of the available search fields for
completed sessions.
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Completed: For searches of sessions that are completed and indexed, the available
templates are listed under the Active heading. These search templates can be
configured to search for data that is inserted or otherwise modified after the
session completes.

All Sessions: These templates can be used to search both active and completed

sessions. When a search is run, one query examines the active sessions, and
another query is formed to search the completed sessions.

Selecting a search template
To change the current search template:

1.

To select a different template, click the hyperlink or click Select Template in the
toolbar.

Template Selector

Q

[+ Active

+H Completed

=l all Sessions
<all Sessions Lo

<[Default All Sessions=

ginID Search=

¥ Yiew by Labels

e

Figure 10. Template

The list of available templates is displayed in the Template selector.

* Templates that are listed in the template selector are based on your template
permissions. These permissions are defined per template per group.

* To filter the results, select the Filter check box and enter a value. The list is
filtered to display only matching results.

* To view the list by search template type, click theView by Labels check box.
* To view the list in alphabetical order, clear the View by Labels check box.
Select the template to use.

To use the selected search template, click Select.

The search fields are updated based on your selection.
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Session list template

Similar to the search template, a session list template is a predefined set of fields that
are used to display sessions that are returned in a search.

For each matching session, the session list template defines the fields of data that
pertains to the session to show in the Portal.

To change the session list template:
1. Perform your search.

2. In the displayed results, select a different template from the Session List
Template drop-down in the upper-right corner.

3. The Session List is automatically updated to display the fields that are
configured for the session list template for each of the matching sessions.

Changing the preceding session list template applies only to the current search.

* A Tealeaf administrator can assign a default session list template to each search
template. For more information about configuring search templates, see
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Configuring templates

Search templates and session list templates are defined by your Tealeaf
administrator. For more information about configuring search templates, see
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration Manual.

Other search criteria

In addition to the search terms you define for your search, you can refine your
search by using the following tools:

1. “Search Range” - Configure the date range to search for matching sessions.

2. “Search scope” on page 18 - Configure how multiple criteria are matched in a
search.

3. “Search options” on page 19 - Configure additional options.

Search Range

Above the search criteria pane is the Search Range drop-down, from which you
can select or specify a range. Next, to it is displayed the available dates of session
data available on the currently selected Canister or Canisters.

Template: =Default Completed= This will search across available Completed sessions,

Search Range: f<Specify = ‘v | Available Dates: 10/21/2010 00:00 - 10/28/2010 15:41

Fram: |10/28/2010 |00:00:00

To:  |10/28/2010 [23:59:59

Figure 11. Specify a Search Range
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From the Search Range drop-down, you can select the range of dates in which
sessions are examined for matches. The following options are explained here:

Search Range Option
Description

Latest 5 Minutes
Searches the most recent five minutes of sessions that are indexed among
the available date-time range (completed sessions only).

Latest Hour
Searches the most recent hour of sessions that are indexed among the
available date-time range (completed sessions only).

<Specify>
Specify your own search range. See “Specifying a search range.”

Specifying a search range

To specify your own range:

1. To specify your own date and time range, select <Specify.
2. Enter the From and To dates and times.

* When you specify a time, you can use the arrow keys and TAB and ENTER to
make your selection. To cancel the time configuration, press ESC.

3. The specified range is applied when you run your search. For more
information, see running your search.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Search scope

You can define the scope of the search regarding matching criteria across pages
within a session.

Search Scope: | AND - Sare Session ;l

Figure 12. Search Scope
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Option Description

AND - Same Session
Match all fields across all pages.

AND - Same Page
Match all fields in a single page.
Note: Above option is only available for Completed search templates.
Note: And on Same Page searches cannot include negative operators on
search criteria.

OR - Any Session
Match any fields across any pages.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.
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Search options

Each search template contains a list of options. Depending on the type of search

template that you have select, the following options are displayed:

Search Options

Search Time Zone: (UTC-08:00) Pacific Time (US & Canada)
Session List Temnplate: | = Default= -
Sort Results By: | Murn Hits B
Search Servers: ZIEREAZ Search

Automatic Search Timeout: | 90 Seconds ;l

Automatic Stop Limit: | 10,000 -]

Figure 13. Search Options

Option Description

Search Time Zone

(Completed only) For Completed searches, you can select the time zone to

use for your search. When a different time zone is selected, the date and
times that are applied to the search are defined about the selected time

zone.

* By default, the applied time zone is the local time zone for the Tealeaf

user.

Session List Template

Select the session list template to use with the current search.

* To use the one auto-assigned with the base search template, select

<Default>.

* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Sort Results By

The method by which to sort the returned sessions. This setting also
determines the order in which sessions are matched against the search,
which can impact the sessions that are returned if the search is canceled.

* The available options vary depending on whether you are using an

Active or Completed search template.

Chapter 4. cxReveal - Searching for Sessions
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Search Servers
Select one or more servers whose Search Servers are queried when the
search is run.

Automatic Search Timeout
(Completed only) The length in time that the search must run before
stopping and returning any matched sessions.

* By default, this value is set to 90 seconds.
Automatic Stop Limit

(Completed only) The maximum number of sessions that are found before
the search is stopped and any matches are returned.

* This value is applied to each server. So, if your search is spanning four
servers, the maximum limit is defined as four times this value.

* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

* For more information about customizing search templates, see "Configuring
Search Templates" in the IBM Tealeaf cxImpact Administration Manual.

Managing searches

You can manage searches by saving or opening searches.

Saving searches
To save a search:

1. To save the currently specified search, click the Save ( ) icon in the
toolbar.

2. In the Save Search dialog, enter a name for the search.
3. If you want to share the search, click the Save check box.

Note: Saved searches are available to all Portal users.
4. To save the search, click Save.

* To cancel the save, click Cancel.

Opening searches

To open a saved search:

1. Click the Open ( ) icon in the toolbar.
2. The Saved Searches dialog is displayed:
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Saved Searches X

test_search

Q alltext-plesser

Figure 14. Saved Searches

3. Select the search to open, and then click Load. The search fields and left
navigation pane are populated with the criteria of the saved search.

* Searches that are shared with you are marked with a shared (ﬁ ) icon.
* To edit the properties of a search you saved, select it and click Edit.

Note: You cannot edit a search that is shared with you.
* To delete a saved search, select it and click Delete.

Note: You cannot delete a search that is shared with you.

Reference

* For more information about searching for sessions, see "Searching Session Data"
in the IBM Tealeaf cxImpact User Manual.

* For more information about configuring search and session list templates, see
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Building and submitting a search

Through session search, you can search active, completed, or both types of sessions
that are based on a set of criteria that you define.

For general information about searching for sessions, see "Searching Session Data"
in the IBM Tealeaf cxImpact User Manual.

You can select a search template and build your search by making selections in the
Search Fields pane. When you specify your search, you must define your terms as
narrowly as possible. If you can identify unique characteristics of the session
segment, then your search results are returned faster and are of better quality.
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Note: You can include up to five terms in a IBM Tealeaf cxReveal search. This
limitation does not apply to All Text, Text in Request, and Text in Response fields.

search Configure Help {GMT-7) SR Logout

| Search Online Help [

Eearch Bangs: | Only Today = | Awailsbls Dates: 072452000 O0;00 - 08ME/Z010 11:42

I
Basic Search Fields Search Scope: iﬁ.NI:I - Gamie Sesson -'l
Al Tk
Test in Request et X
Taik in Responss All Text [includes =] [Fi=szer
Events
Event Values
SaEsinn [Afs
Sassion | inchides =] Acquistion Struggle with Customsr - [Gthers]

Figure 15. Search

Search template

A search template defines the type of search you are performing and the available
terms that you can use to specify a search. Search templates can be defined by a
Tealeaf administrator.

* For more information about selecting a search template, see "Selecting and
Modifying Search Options" in the IBM Tealeaf cxReveal User Manual.

* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Selecting dates

Below the listed search template, you can review the dates for currently available

session data. By default, session search is configured to search only today's

sessions.

* To change the search range, select a different range from the Search Range
drop-down.

e See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Specifying a search

After you select a search template to use, you can specify the search terms to
include in the search and the criteria of each term.

In the preceding image, two search fields are added to the search. The currently
selected search template defines the set of fields available in the list. On the right
side of the pane are the fields that are currently part of the search you are defining.

* To add a field to the search, click a field type in the Field Selection pane. Then,
click the link to the field. The field name and a text box are added to the Search
Configuration Window.

— See “Field Types” on page 23.
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— See “Search Configuration Window.”

* After a field is added to the Search Configuration Window, you must specify the
criterion or criteria for the search term. See “Field criteria” on page 24.

¢ To remove a field from the list, click the X next to its name.

Note: If a field does not have an X next to its name, the field is required by the
template and cannot be removed. It must be populated to run a search.

Field Types

In the Field Selection panel, the search terms available in the currently selected
search template are organized into groups. These groups can be defined in the
search template.

The groups that are used in the default templates are listed.

Search Field Group
Description

Basic Search Fields
Search for text in the request or response or events. In completed sessions,
you can search for event values.

Session Info
Information pertaining to the visitor's session is recorded and maintained
by Tealeaf so that you can search on it.

* Annotations added to the sessions by Tealeaf users can be available for
search.

Page Info
Page-level information that is captured by Tealeaf can be searched by using
the search fields in this group.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Search Configuration Window

When you select a search term, it is displayed in the main panel. The Search
Configuration Window represents the fields that you select to include in the search
and any criteria for the field.

* You can also select whether the defined term is included or not included in the
text field.

Note: Empty search fields are not applied to the search.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Search Scope

From the Search Scope drop-down, you can select how the populated search fields
are logically bound in the search.

Option Description

AND - Same Session
All given fields must match against a session.

AND - Same Page

(Completed only) All given fields must match against a single page in a
session.
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OR - Any Session
Any given field must match against the session.

Field criteria

Depending on the type of search field, you might be required to specify extra
criteria, including values for the fields and any search operators to apply.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Submitting a search

When you add all fields, specified operators, and entered field values for your
search, click Search to submit it. Empty fields are not applied to the search.

Note: Depending on the search terms and values that you specified, the search can
take a while to return results. Define your search terms as narrowly as possible.

search Configure Help

{GMT-7) SR Logout

Search Online Help

Search Status

Templats: =Dwalault Complateds This will sssrch scross

0% Complata
Search Range: | Only Taday =| Available Dates: 0 | |
Basic Saarch Fialds Search Scope: lAND - Sam
Sesseons Found: o
all Text
Taxt in Reguest Al Text Ocourrences Found: o —
Tastir Regponce Al Text [includes 4 Indexes Searched: o/ 0
Events
Event Waluss Tirn Elapid: .16 $ec
Enttion ol Aute Stop Limit 0
Session | includes ]
=

Figure 16. Search Status Dialog

As your search is being processed, a search status dialog displays progress.

* To stop the search at any time, click Stop Search. Any retrieved search results
are displayed in the session list.

* To cancel the search without returning results, click Cancel Search.

After a search is completed, the results are downloaded and collated for display.
Depending on the number of sessions that are returned, it can take a while for
these processes to complete. They cannot be canceled.

Search results are displayed as a list of sessions. See "Search Results" in the IBM
Tealeaf cxReveal User Manual.
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Toolbar

The search toolbar is located at the top of the page.

Select Template Search Options

Figure 17. IBM Tealeaf cxReveal Search Toolbar

The following tools are displayed from left to right in the toolbar.
Tool Description

Reset Reset the search to the default fields and values that are specified in the
search template.

Save Search
Save the current search. See "Selecting and Modifying Search Options" in
the IBM Tealeaf cxReveal User Manual.

Open Saved Search
Open a search that is been previously saved. See "Selecting and Modifying
Search Options" in the IBM Tealeaf cxReveal User Manual.

Link to Search
Display a URL to the specified search. See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.

Select Template
Click to select a different search template, which enables searching for a
different type of session: active, completed, or all sessions. See "Searching
Session Data" in the IBM Tealeaf cxImpact User Manual.

Search Options
Click to open search options. See "Searching Session Data" in the IBM
Tealeaf cxImpact User Manual.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Reference

Other online documentation can include additional details on searching for session
data.

* For more information about searching for sessions, see "Searching Session Data"
in the IBM Tealeaf cxImpact User Manual.

* For more information about configuring search templates, see "Configuring
Search Templates" in the IBM Tealeaf cxImpact Administration Manual.

Search Results

In the Session List screen, you can review the list of sessions that are returned from
your search. The retrieved sessions are displayed in tabular form in the session list.

* You can use the controls above the session list to sort or otherwise change the
displayed sessions. See “Session List Commands” on page 28.
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Types of searches

IBM Tealeaf cxReveal supports two types of searches:

1.

Session searches - These searches examine individual Canisters (Processing
Servers) for matching sessions by using a wide range of criteria.

Note: Session searches are most useful for completing exploratory or discovery
searches when the results are not well-known at the time of search.

Note: For IBM Tealeaf cxReveal users, completed searches do not generate
session segments, since most searches retrieve few sessions. IBM Tealeaf
cxReveal admin users, however, can generate session segments that are based
on run or reviewed searches by other IBM Tealeaf cxReveal users. See
"Managing Session Segments" in the IBM Tealeaf cxResults User Manual.

* Session searches use search templates from IBM Tealeaf cxImpact. For more
information about specifying these types of searches, see "Searching Session
Data" in the IBM Tealeaf cxImpact User Manual.

Database searches - Optionally, IBM Tealeaf cxReveal can be configured to
capture session attribute information as soon as it is detected and to insert it
into a high-speed database for immediate retrieval.

Note: Database searches are most useful for locating specific sessions for

replay.

* Database search requires additional configuration. See "Configuring Session
Attribute Search" in the IBM Tealeaf cxReveal Administration Manual.

* For more information about specifying IBM Tealeaf cxReveal database
searches, see Chapter 5, “cxReveal - Searching Sessions by Session Attribute,”
on page 33.

Searches of both types are displayed in similar session lists, which are described
here.

Session List

The Session List contains all sessions that matched the search criteria that you
specified.
¢ Just below the Portal menu, the navigation bar displays the pathway that leads

to the current page. To jump to another page in the navigation bar, click one of
the other links in the breadcrumb trail.

* Below the breadcrumb trail, a set of commands is available. See “Session List

Commands” on page 28.
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Figure 18. IBM Tealeaf cxReveal Session List

In the displayed list, each row represents a different session that matches your
specified search conditions.

* In the leftmost column, a blue circle marker indicates that the session is an
active session. For more information about the displayed fields, see “Session List
Fields” on page 28.

* To sort the session results by any displayed column, click the column header. To
reverse the order of sorting, click the header again.

* To group results according to a column, drag the column header to the blue bar
above the displayed headers. The displayed sessions are organized according to
the column.

* To review details on an event, move the mouse over its icon. The tooltip is
displayed.

— Additional detail on the execution of a specific event within the session can
be retrieved from the QuickView page. See “Session List Icons” on page 28.

* The list of sessions can be displayed across multiple pages. Use the page links at
the bottom of the list to browse to other pages in the list.

* Optionally, you can download the displayed sessions or session list data. You
can display the list of sessions in a different session list template, which can
contain other useful fields of information that can be downloaded. See “Session
List Commands” on page 28.
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For more information about session lists, see "Searching Session Data" in the IBM
Tealeaf cxImpact User Manual.

Displayed Session Limits

By default, IBM Tealeaf cxReveal searches are limited to a total of 100 returned
sessions.

* This limit can be configured by Tealeaf administrators. See "cxReveal Settings” in
the IBM Tealeaf cxReveal Administration Manual.

* Another limit to the number of sessions is defined per search template. Typically,
this value is much higher than 100. Therefore, the base setting is applied. See
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

The search results can indicate that more than 100 sessions have been found. Only
the first 100 are displayed and accessible through the Portal.

Note: To display sessions that are not returned in the initial search, you can sort
the results by the Hit column or the Session Time column and then refine the
search criteria to retrieve results only between the last session in the current list
and the limit that is specified in the search configuration.

Session List Fields

By default for completed session search, the following fields are displayed in the
session list:

* For more information about the displayed icons, see “Session List Icons.”
Field Description

Session Time
The time and date for the most recent page in the session.

Duration
The duration in seconds of the session.

Login ID
The login identifier, if applicable, that was used during the recording of the
session.

Events
Any Tealeaf events that were triggered during the session. For more
information about a session event, move your mouse over its icon.

Hits  The number of hits in the session.

Session List Commands

The following sections describe the available commands in the session list page.

Session List Icons
At the top of the session list and in each row of the session list, you can select one
of the following command icons.
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Table 1. Session List Icons

Icon Command Description

Replay To replay a session, select it, and click
the Camera icon next to it.
Depending on your group
permissions, user permissions, or
both, you can choose to replay the
selection in the browser or in the IBM
Tealeaf CX RealiTea Viewer if it is
installed on your local desktop and
enabled in your Tealeaf solution.

21z

* For more information about
browser replay, see "CX Browser
Based Replay" in the IBM Tealeaf
cxImpact User Manual.

* RTV is a stand-alone application
that must be installed on your local
desktop. For more information
about browser replay, see "RealiTea
Viewer (RTV) User Manual" in the
IBM Tealeaf RealiTea Viewer User
Manual.

Page List View the page list for the session. See
"Searching Session Data" in the IBM
Tealeaf cxImpact User Manual.

%

'iﬂ QuickView View the events and any related

dimensional data for each event
firing in the session. See "Searching
Session Data" in the IBM Tealeaf
cxImpact User Manual.

Session Info View session properties. Depending
i on the type of session, the session
properties vary:

» For active sessions, the session
properties include all possible
session attributes regardless of
whether they are populated with
values.

* For completed sessions, the session
properties include session
attributes that are populated with
values. Fields that are not
populated with data from the
session are excluded.

Event Tester Send the selected event to the Event
@1 Tester as sample data. See "Event
Tester" in the IBM Tealeaf Event
Manager Manual.

Exporting Search Results
You can export your search results to a file, which can be imported and into
another application.

To export all sessions that are displayed in the session list, click Export, then select
one of the following options:
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Export option Description

Export to RTV Download a file that can be opened in the
IBM Tealeaf CX RealiTea Viewer (RTV) later
to retrieve the session list.

Export to Excel Download the session list to Excel (XML)
format.

Export to PDF Download the session list to PDF format.

Export to Digital Analytics Download the session list for integration

into IBM® Digital Analytics. For more
information, see "IBM Digital Analytics
Integration Solution" in IBM Tealeaf
cxConnect for Web Analytics.

See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Session List Template selector

You can select a different session list in which to display the current list of
sessions. Make your selection from the available templates in the Session List
Template drop-down in the upper-right corner of the session list.

* Session list templates can be configured by a Tealeaf administrator and
associated by default with a specific search template. See "Configuring Search
Templates" in the IBM Tealeaf cxImpact Administration Manual.

* IBM Tealeaf cxReveal session list templates can display more data that is tracked
in the IBM Tealeaf cxReveal search database. See "Configuring Session Attribute
Search" in the IBM Tealeaf cxReveal Administration Manual.

Additional Search Results Information

sSesslons Roturned Sessions Found Time (5)
PaLlzabESs £l 21 LAI]

Search Juery: (numhits == 2)
Figure 19. Search Server Information

Search Server information

At the bottom of the Session List, you can review the Tealeaf servers that were
searched for these results. To see the search results from each search server, click
Show Server Results Distribution.

For each server, you can see how many sessions were found, how many were
returned, and the elapsed time to complete the search.

Search query
The specific search query that was passed to the search engine for execution is also
listed.

Note: This search query can be inserted into All Text search fields, modified, and
submitted as needed. Copy the text and paste it into the appropriate field for
modification.

Search range
The timestamps that indicate the range of session data that is used to specify the
search are listed at the bottom of the search results.
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Sub-Search

When a session is loaded in Browser-Based Replay, you can configure and
complete a search for additional search strings to locate the specific hits in the
session where these search strings are located. This sub-search capability enables
search for text strings, request variables, or request variable values.

¢ See "Sub-Search in BBR" in the IBM Tealeaf cxImpact User Manual.

Chapter 4. cxReveal - Searching for Sessions
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Chapter 5. cxReveal - Searching Sessions by Session
Attribute

Through session attribute search, IBM Tealeaf cxReveal users may search for
sessions that are based on session attribute information that is captured by Tealeaf
and recorded in the IBM Tealeaf cxReveal database.

For example, if visitors to your web application must log in to use it, IBM Tealeaf
cxReveal can be configured to capture the login identifier and store it in the IBM
Tealeaf cxReveal database, as soon as the identifier is detected in the session data.
If the value for the login identifier is captured in the first hit to (typically)
SessionAttribute00, then the user's session is available as soon as that hit is
captured and processed by Tealeaf. Through session attribute search, IBM Tealeaf
cxReveal users can have immediate access to active sessions, which facilitates
managing customer support inquiries and other customer-focused activities.

Note: Searching by session attribute is a component of cxReveal, a separately
licensable component of the Tealeaf CX platform. For more information, please
contact your IBM Tealeaf representative.

This information describes how to configure and run searches for sessions by using
session attribute information.

Overview of Session Attribute Search

Note: Before you begin searching by session attribute, your Tealeaf solution must
be configured to capture session attributes, which can require additional
installation and configuration. See "Configuring Session Attribute Search" in the
IBM Tealeaf cxReveal Administration Manual.

To run a session attribute search, you use a search template of IBM Tealeaf
cxReveal type to specify the session attributes and their values that match the
session or sessions for which you are looking. As in standard Portal search, you
can configure the appropriate date range, and also other options.

When the search is run, the Portal queries the IBM Tealeaf cxReveal database
through the Tealeaf Data Service for matching values to the specified session
attributes. The search is run against a single, high-performance database that
contains only the session attribute information and the data that is required to
locate the sessions among the Canisters in the Tealeaf system. Thus, search results
are returned much faster.

* A session record is written to the database as soon as the first session attribute is

detected in the capture stream. So, the session can be available for search
through session attribute search as soon as the first hit is processed by Tealeaf.

Search results from a session attribute search are displayed in a standard session

list. From the session list, you can replay the session in Browser-Based Replay or
the IBM Tealeaf CX RealiTea Viewer, if installed.
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Differences between cximpact Search and cxReveal Search

A IBM Tealeaf cxImpact search queries the Tealeaf Search Server, which queries the
appropriate Canisters in the Tealeaf environment for sessions. Depending on the
type of session:

e Active sessions: Search Server examines the Short Term Canister, which is an
in-memory database on the Processing Server.

* Completed sessions: Search Server examines the Long Term Canister, which is a
disk-based on the Processing Server.

A single search of multiple Canisters across Active and Completed sessions can
create multiple searches that are run by Search Server. This process can take a
while to return results.

By contrast, IBM Tealeaf cxReveal session attribute search makes a single query of
a single database.

* If including Canister data is enabled in session attribute searches, queries are
passed to Search Server to run against each Canister to retrieve relevant session
information. Since these queries retrieve summary information about the session,
they are still faster than IBM Tealeaf cxImpact search.

¢ The maximum number of returned sessions is limited to 100. Results are
returned based on the last use of the session, which is recorded as a timestamp
in the database record. More recent Last Use values are listed first.

— For completed sessions, the Last Use value is the time when the session was
closed.

— For active sessions, the Last Use value records the last time the database
record was updated with a new or changed session attribute.

Since a session attribute search queries a database, the accepted wildcards and the
available comparison operators are different. They are described in more details.

Note: The IBM Tealeaf cxReveal database stores only the latest value of each
session attribute for a given session. You cannot use session attribute search to
track changes in values of session attributes throughout the session. For example,
searching for a specific URL is unlikely to return results, unless the latest or last
URL of a session is a match.

Note: Session attribute search in IBM Tealeaf cxReveal is best utilized for searching
all sessions by using a well-known session attribute for purposes of retrieving and
replaying the session. Typically, this session attribute is the identifier of the visitor
to your site.

IBM Tealeaf cxImpact search is more appropriate for exploratory or generalized
searches. IBM Tealeaf cxImpact searches request and retrieve a larger volume of
data, which is helpful if you are unsure of your wanted session or hit.

Selecting cxReveal search templates

34

Session attribute searches can use any session list template of IBM Tealeaf cxImpact
type or IBM Tealeaf cxReveal type. However, to query the IBM Tealeaf cxReveal
database, a search template of IBM Tealeaf cxReveal type is required.

* A IBM Tealeaf cxReveal search template cannot be used for IBM Tealeaf
cxImpact searches.

* See "Configuring Session Attribute Search" in the IBM Tealeaf cxReveal
Administration Manual.
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If IBM Tealeaf cxReveal is not configured to access Canister data, only session
attributes that are marked for tracking in the IBM Tealeaf cxReveal database can be
retrieved by using a IBM Tealeaf cxReveal search template. This data includes the
IBM Tealeaf cxReveal session attribute fields, first use, last use, Canister Name,
Tealeaf session ID, and session ID.

* For more information about marking session attributes for tracking and search,
see "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager Manual.

¢ See "Configuring Session Attribute Search" in the IBM Tealeaf cxReveal
Administration Manual.

After IBM Tealeaf cxReveal search templates are configured, you can select them
through the Portal in the usual manner.

1. From the Portal menu, select Search and then select the type of search to
complete: Active Sessions, Completed Sessions, or All Sessions.

2. The Portal search screen is displayed.
* See "Searching Session Data" in the IBM TealeafcxImpact User Manual.

3. Based on your menu selection, the default search template of the selected
search type is displayed in the main panel.

4. To select a different search template, click Change... next to the name of the
current search template.

5. In the Template Selector, select one of the IBM Tealeaf cxReveal search
templates.

* In the Template Selector, you can select a IBM Tealeaf cxReveal template for
any type of search. The Portal search screen is automatically updated to use
that template.

Note: Unless there is a specific reason to limit your searches to active
sessions or completed sessions, you must select a search template of IBM
Tealeaf cxReveal type for All Sessions. Session attribute searches by using
this search template make a single query to the same database. In IBM
Tealeaf cxImpact, All Sessions searches require multiple queries of different
components of the Tealeaf system.

* For more information about the names of your IBM Tealeaf cxReveal search
templates, contact your Tealeaf administrator.
6. If you want, you can select a different session list template in which to display
search results. See “Selecting a Session List Template.”

7. Specify your search scope from the Available Dates. Available dates differ from
those dates available through IBM Tealeaf cxImpact search. See “Available
Dates” on page 36.

8. The available search terms are displayed in the main panel. See “Specifying
Search Terms” on page 36.

Selecting a Session List Template

Similar to a search template, a session list template is required for displaying the
returned results from a search.

The default session list template setting that is specified for IBM Tealeaf cxImpact
does not apply. That session list template applies only to drill-down searches from
reports in the Portal. See "CX Settings" in the IBM Tealeaf cxImpact Administration
Manual.

You can select a session list template through the Portal in the usual manner.

1. In the Portal search screen, select the search template to use.
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2. From the Session List Template drop-down, select a session list template.

3. When your search is run, sessions returned in the search results are displayed
in the selected session list template.

* See “Search Results” on page 25.

Specifying Search Terms

In the main panel, you can select one or more of the available terms to use in your
search.

Note: The IBM Tealeaf cxReveal database retains only the last stored value for
each session attribute. It does not keep a historical record of values that have are
assigned to each attribute.

* Session attributes are stored as text data.
— You cannot perform numeric comparisons on them.

— To retrieve date information that is stored in session attributes, you must
know the exact format of the date value that is stored in them.

Note: If a session attribute does contain numeric data, you can be able to
locate instances of specific values. Do not enter the exact value. Enter the
integer value or as many consecutive digits of which you are certain. Then,
apply the Tike operator. Depending on how many digits you specify, you are
likely to return a hit. However, you can also return other unwanted results.

* If no search terms are specified, the submitted search queries the specified date
range for all sessions, active, or completed, depending on the type of selected
template.

Session attribute searches are specified in the same manner as searches by using
other types of search templates.

* See “Building and submitting a search” on page 21.

Available Dates

The Available Dates indicate the session data that is stored in the IBM Tealeaf
cxReveal database. It does not reflect the available dates in the Canisters.

Note: For optimal search performance, specify a narrow date range when you
define your search terms.

* Be sure to specify the appropriate date range.

cxReveal Comparison Operators
IBM Tealeaf cxReveal search templates support the following operators.

When you specify a search term by using a IBM Tealeaf cxReveal template, you
can apply one of the following operators to the search criterion in the textbox.

Operator
Description

equals Entered value exactly matches the most recent recorded value for the
selected session attribute. Not case-sensitive matching.

does not equal
Entered value does not exactly match the most recent recorded value for
the selected session attribute. Not case-sensitive matching.
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like  Entered value is similar to most recent recorded value for the selected
session attribute. Submitted value can be partially matched to the selected
attribute.

* This operator is not available if MD5 hashing is applied to the search
field.

not like
Entered value is not similar to most recent recorded value for the selected
session attribute. Submitted value does not partially match the selected
attribute.

* This operator is not available if MD5 hashing is applied to the search
field.

Modify Search Options

As needed, you can change options for your search by using the left panel of the
Portal search screen.

The following options are available for IBM Tealeaf cxReveal searches:
* Sort Results By

* Search Servers

* Automatic Search Timeout

* Automatic Stop Limit

See “Selecting and modifying search options” on page 15.

Running Searches

After you specify your search terms and search options to run your search, click
Search.

The Search Status dialog updates you on the progress of your search. When results
are found, they are displayed in the selected session list.

* For more information about troubleshooting issues, see "Troubleshooting -
cxReveal” in the IBM Tealeaf Troubleshooting Guide.

Search results

When search results are returned, they are displayed in the selected session list
template.

¢ The maximum number of returned sessions is 100 by default.

* By default, search results are returned based on the value of the Last Use
column.

Note: The IBM Tealeaf cxReveal database retains only the last stored value for
each session attribute. It does not keep a historical record of values that are
assigned to each attribute. Search results display only the latest value that is
inserted into the database.

The session list can contain multiple entries for the same session. These session
fragments can split entries for the values of session attributes. If you believe two
entries in the session list come from the same session, refer to the timestamp for
each entry to determine the final values for the session attributes.
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* At replay time, session fragments can be reassembled into a single complete
session. See "BBR Options" in the IBM Tealeaf cxImpact User Manual.

For more information about search results in IBM Tealeaf cxReveal, see “Search
Results” on page 25.

In the session list, you can scan the results to find the matching session. Links are
available in the left column to review the list of pages, review session information,
or replay the session through your browser or through RTV.

* For more information about replay through your browser, see "CX Browser
Based Replay" in the IBM Tealeaf cxImpact User Manual.

e Replay through RTV requires installing the RTV application on your desktop
system. See "RealiTea Viewer (RTV) User Manual" in the IBM Tealeaf Realilea
Viewer User Manual.
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Chapter 6. cximpact Browser Based Replay

oxImpact Browser Based Replay (BBR) enables the replay of visitor sessions
directly through your web browser. Through an easy-to-use interface, you can
review in real time all pages in visitor sessions as they are displayed to the user.
Or, you can quickly step through selected pages to identify issues that occurred
during the session.

The following terms are frequently used:

Replay
A replay is the display of the visitor's experience with your web
application. By assembling all of the requests, responses, and related data
in the sequence of the visitor session, the Tealeaf® system can replay the
session through Browser-Based Replay to accurately mimic the visitor
experience.

You can replay both active sessions and completed sessions.

Additionally, users with Admin authorization can view page load details in
real-time to assist with diagnostics and to help identify specific files that
might be the cause of discrepancies in fidelity.

For information about how to use real-time logging of Replay Server, see
"Using real-time page load logging information for session diagnostics" in
thelBM Tealeaf cxImpact Administration manual.

For information about how to configure the Replay Server to use real-time
logging, see "Replay Server Configuration" in the IBM Tealeaf CX
Configuration manual.

Active session
An active session is a visitor session with the web application to which the
visitor is adding pages right now by browsing the website.

During replay of active sessions, BBR automatically refreshes active
sessions on a periodic basis. When an active session is refreshed, the
currently displayed page is not refreshed. When UI events are part of the
current page, a refresh can cause replay to jump to the previous standard
page and disrupt the replay.

Completed session
A completed session is a visitor session that the visitor has completed or
abandoned or that has been timed out by Tealeaf.

Browser Based Replay runs entirely within the Portal and requires no additional
software installation for Tealeaf users.

Note: BBR maintains and forwards to your browser the required Set-Cookie
headers to properly replay a session. To ensure that the Portal cookies are
maintained, Tealeaf resends them at the end of each request. If the maximum
number of permitted cookies is exceeded, the oldest cookies in your browser are
discarded, which enables BBR replay and your Portal session to be sustained.

BBR is an alternative to Tealeaf's IBM Tealeaf CX RealiTea Viewer (RTV) desktop

application, which must be installed on each user's desktop system as an advanced
search and replay system.
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Overview

You can use BBR to complete the following functions:

* Replay visitor sessions or track live visitor sessions as they occur.

— Replaying active sessions as they occur enables you to provide real-time
customer support for customers and to diagnose web application issues that
you are personally experiencing.

* Show visitor input, such as entered text, selected menu options, and clicked
links or buttons.

Track activities that occur on different views of a dynamic page.
* View the raw request and response data.

¢ Drill down into session details.
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Figure 20. Browser Based Replay (BBR)

Opening BBR
To open BBR, complete the following steps:

For Active Sessions

1. Select Active > Sessions in the Tealeaf Portal menu.

&
2. Next to the session you want to replay, click the Replay icon ( )-
3. In the popup dialog, select Browser.
4. The selected session is opened in BBR in a new browser window.
* See "Monitoring Active Sessions" in the IBM Tealeaf cxImpact User Manual.
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For Completed Sessions

1. Select Search > Completed Sessions in the Tealeaf Portal menu.
2. Select a Completed search template.

3. Specify the search criteria for which you are looking.

4. Next to the session you want to replay, click the Replay icon ( )-
5. In the popup dialog, select Browser.

6. The selected session is opened in BBR in a new browser window.

Replaying Sessions

You can examine pages as they are displayed to the visitor and replay the visitor's
experience through your web browser.

For best replay results, replay the session in the same browser that was used to
create the session. This information is displayed along the User Agent Information
Bar under Best Replayed Using.

Note: Replay of sessions across multiple browser tabs or multiple browser
windows is not supported.

Note: BBR cannot set cookies that are intended to be captured as part of the visitor
experience. If cookies are integral to replay, you must use the IBM Tealeaf CX
RealiTea Viewer desktop application instead.

Replay View
To view a page as the visitor saw it:
1. Select the page in the Navigation pane.

2. In the toolbar, click the Replay icon ( Replay ).
Replay Session
To replay the entire visitor session:
1. Select the page at which to begin the replay in the Navigation pane.

2. Click the Start Replay (| start Replay ) icon in the toolbar.

3. You can choose to replay the session as it was captured or to delay each page a
preset number of seconds.

During replay, a counter at the top of the page indicates how many seconds
remain in the replay of the current page.

* To stop replay at any time, click the Pause ( Stop Replay ) icon in the
toolbar. The currently replaying page remains in the Content Pane for further
exploration.

Replaying sessions from mobile visitors

If you have licensed and enabled the IBM Tealeaf CX Mobile module, BBR
supports the replay of user interface events that are captured from the visitor's
mobile browser.
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To render sessions that are captured from mobile devices for display in the web
browser, the Tealeaf Replay Server uses an embedded renderer that is based on the
Chromium engine. For best results in replay of mobile-based sessions, use the
Chrome browser in Browser-Based Replay.

The IBM Tealeaf CX Mobile module is a separately licensed module of the IBM
Tealeaf CX platform. please contact your IBM Tealeaf representative.

Note: If IBM Tealeaf CX Mobile module has not been licensed, there are limitations
that are applied to replay of sessions in BBR.

The manner in which you work with mobile device sessions in BBR is basically the
same as it is for non-mobile device sessions.

When you replay sessions from a mobile device in BBR, a graphical representation
of the device is displayed in the viewing area.

Select Options > Resize View to Match Session when replaying a mobile device
session.

The visitor interactions with the mobile application are depicted graphically. For
example, if the visitor tapped two times on a Ul element on the mobile application
screen, BBR depicts this action on the screen in the viewing area as follows:

Mobile device gestures in BBR

When a visitor interacts with your mobile-based web site, mobile app, or native
hybrid app using a touch device (for example, a smart phone or tablet), you can
replay the gestures from that experience in BBR.

The capability to capture and replay mobile device gestures (for example, tap and
swipe gestures) gives you insight into interactions that are specific to a mobile
device user's experience.

Note: If there is no mobile licence, gesture Replay is not supported.

Being able to view mobile device gestures in BBR can help you identify and
troubleshoot customer pain points and address design flaws in your web site or
application that otherwise might have gone unnoticed. For example, lets say your
business has a mobile banking application for your customers. A customer accesses
the banking application from their mobile device to view their account balance.
After viewing their account balance, the customer wants to go back to the
application's home page to perform a different transaction. The user taps the logo
in the top of the account balance page several times, assuming that the logo
functions as a link to the home page. However, the application developer for the
mobile app did not code the logo to link to the home page. As a result, the user is
frustrated and confused about how to navigate back to the home page. By having
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access to mobile device gestures in BBR, you can see where the visitor struggled
(multiple taps on the logo) and you can share this information with the mobile app

developer.

Note: Highlighting in BBR is not supported for mobile gestures (typell messages).

Gestures are enabled in the supported frameworks as follows:

Table 2. Enabling gestures reference table

Framework

Method for enabling

For more information see

iOS

Gestures are enabled in the
TLFConfigurableltems.plist file in
each application in which you want
to capture gestures.

IBM Tealeaf CX Mobile iOS Logging
Framework Guide

Android

Gestures are enable in the
mainActivity.jar file in each
application in which you want to
capture gestures UIC.

IBM Tealeaf CX Mobile Android
Logging Framework Guide

Java-based
web
application

Gestures are enabled in the
TealeafSDK.js file configuration
object.

IBM Tealeaf CX UI Capture j2 Guide

Analyzing gesture events in BBR

When you replay sessions from a mobile device in BBR, a graphical representation
of a mobile device is displayed in the viewing area.

Like standard BBR, you can replay the customer's session from beginning to end,
or you can go through the session one page at a time by clicking the Ul events in
the Navigation pane.

The gestures are displayed graphically on the graphical representation of the

device.

Additionally, you can review the request and response message formats.

Session Timeout

If a BBR session has been idle for 30 minutes, it is timed out by the server. If you
fail to browse to new pages within the timeout period, you must close and reload
the session in BBR to continue navigating.

¢ Check the session identifier and the page you were on before you click Close.

Finding Pages

In the Navigation pane, you can review the pages from the current session that
apply to the current mode. For example, if you are currently in Replay mode, only
pages that can possibly be replayed in BBR are displayed in the Navigation pane.

* To see a list of all pages in the session, click the Page List (

in the toolbar.
* To jump to a page, click the Blue Arrow icon in the leftmost column of the Page

List.

Page List ) icon
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Managing BBR Panes

The Browser Based Replay interface can be altered to display the most important
content that is needed to find pages and replay sessions.

You can toggle the display of the panes in the left sidebar and the entire sidebar,
too.

* To hide the display of the entire sidebar, click the Hide (m) icon in the
BBR toolbar.

* To display the sidebar when it is hidden, select Options > Options > Show
Sidebar from the BBR toolbar.

* To close a subpane, click the X icon in its corner.

Note: You cannot close the Navigation pane. To hide it, close the entire sidebar.

 To redisplay a hidden pane, you can enable it through the Options > Options
sub-menu.

* To minimize a sub-pane, click the Minimize icon in its corner. The other panes
expand to occupy their space.

Searching Archived Sessions for Text

Through BBR, you can search completed sessions for text that you see during
replay. This mechanism is useful for matching the results of active sessions to
activities that are already processed by the Tealeaf system.

1. To search completed sessions for a text string, select Options > Search
Completed Sessions from the BBR toolbar.

2. In the dialog box, enter the text for which to search.

¢ To copy text to the dialog box, select it in the Content pane. Then, in the
dialog box, click Copy Selected Text.

3. To search for the entered text, click Search.
e All available Canisters are searched across the available dates.
* Submitting a search closes the current replay.

* To cancel the search in progress, click Stop Search. Any retrieved results are
displayed.

Sharing Replays

44

You can share your replays with other Tealeaf users. Each replay can be accessed
through a URL on the Tealeaf server, and this URL can be shared with others to
allow them to see the same replay.

Sharing with Email
To send the URL by email:
1. Select Options > Sessions > Send Link by Email from the BBR toolbar.

2. Enter the email addresses of the individuals who must receive the email.
Separate each email address by a comma. Do not include spaces or carriage
returns.

Note: The list of email addresses is authenticated against known users of the
Tealeaf system.
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5.

Enter a title for the replay session. This title is displayed as the display text for
the URL link.

If needed, you can include a message with your replay link.
* You do not need to include the URL in the message.
To send the message, click OK.

Copy the session link

If needed for other purposes, you can retrieve and copy the URL to the clipboard
of your local desktop for pasting elsewhere.

1.
2.

3.
4.

Select Options > Session > Copy Link To Session from the BBR toolbar.

The link is displayed in an address bar at the top of the BBR window. To copy
it, press CTRL + C.

Paste it as needed.
To close the address bar, click theX on the right side of the screen.

Creating Event Data from BBR

Through the context menu in Replay, Request, or Response mode, you can create
events that are based on your selections in BBR. Based upon the selected text, a hit
attribute is created, and an event definition is pre-populated with values to
accurately identify the selected text in the session data.

Note: As a precaution before you begin you must verify that there are no unsaved
changes in the Tealeaf Event Manager.

1.

Select the text. This text might be an HTML element in Replay mode, a
name-value pair in Request mode, a header in Response mode, or another text
selection.

Right-click the selection and select one of the following options:
Option Description

Create New Event from selection...
When text is selected, this context menu command is available for
creating an event from the selected text. The Tealeaf Event Manager is
pre-populated with values to match the selected text.

Create New Hit Attribute from selection...
When text is selected, this context menu command is available for
creating a hit attribute that uses the selected text as the pattern to
match. The Tealeaf Event Manager is pre-populated with values to
match the selected text.

Note: Hit attributes that are created from BBR match on a fixed text
string. Since these attributes always return the same value, they are not
permitted to be used to populate dimensions.

The Tealeaf Event Manager is opened, with the new definition pre-populated
with detection parameters to identify the selection.

Continue specifying the event or hit attribute.
To save changes, click Save Draft.

Note: If you click Cancel to cancel an event creation, the hit attribute to match
the event is already saved as a draft. You must delete the drafted hit attribute
through the Hit Attributes tab or revert all changes, which remove all local,
drafted changes through the Tealeaf Event Manager.
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6. To commit your changes to the server, click Save Changes.
7. The event and hit attribute data are created.

Configuration

You can configure the replay server or associated proxy server.

Configuring the Replay Server

Tealeaf administrators can create and configure Replay Server instances through
the Portal Management page. Multiple Replay Servers can be deployed to
distribute the BBR rendering load among multiple servers.

Configuring BBR replay rules

Tealeaf administrators can configure the replay rules that are applied to
Browser-Based Replay through the Replay Server configuration in the Portal
Management page.

Configuring Proxy
If a proxy is in use to broker connections between BBR users and the Replay
Server and the origin server, review and complete the following configuration
changes.

ESI Tag Support
BBR does provide partial support of the ESI include tags, which are a form of
partial dynamic page caching, without additional configuration. See "RealiTea
Viewer - Replay Rules" in the IBM Tealeaf RealiTea Viewer User Manual.

Browser Based Replay Interface

The BBR window is divided four panes and includes a toolbar and multiple
statistical bars through which you can control replay and review session data.
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Figure 21. Browser Based Replay (BBR) desktop

Ul Components
* Toolbar - The area at the top of the page contains controls and displays for
replaying sessions.
¢ Content Pane - The large window on the right side. It displays replayed hits,
parsed requests, and raw responses.
— Page Statistics - Statistics that are related to the currently displayed page.

* Sidebar - The left sidebar contains multiple panes that enable review of the
session pages, events, and form field data. This page can be toggled for display.
See "BBR Options" in the IBM Tealeaf cxImpact User Manual.

— Navigation Pane - The list of pages within the session that can be replayed.
Click an entry to display it in the content window. Red text indicates a hit
that either returned an error, such as HTTP 400+ or 500+, or a request that the
user canceled before it finished loading.

— Events Pane - The events that fired for the currently selected hit. Each event
links to an event chart report for that event.

— Form Fields Pane - The posted form fields and parsed URL fields that are
associated with the hit. These values are used to highlight the form fields that
the visitor submitted.

* Session Statistics - At the bottom of the page, you can review statistics about the
current session.

Toolbar

Mavigation [ Hide Start Replay Mext Last Request Response Replay
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The top of the replay window contains the following controls and displays.
* Refresh List (Active sessions only)
* Page List

* Hide

* BBR Options

* Start Replay

* First/Last

* Previous/Next

* Request View

* Response View

* Replay View

* Overlays menu

* Annotations

* Close Session

The toolbar can be configured for individual groups or users.

Page List
Page List
Page =
Jj o UIEvent: 1 - 4
= ] Zustormer Login
N1 Ul UIEvent: 1 - 12
= 7 http: ffstraussandplesserncom/store/index . php/customn
= 3 My Account

Ul 23Ul UIEvent: 1 - 4

= 4 Strauss and Plesser

4 ur UIEvent: 1 - 3

= 5 Cameras - Electronics - English

= 5 Digital Cameras - Cameras - Electronics - English

N 6 Ul UIEvent: 1 = &

= 7 http: ffstraussandplessercomstorefindex . php/wishlist,

= 3 My Wishlist =
<] I id |

Figure 22. Page List

Click the Page List button to open a window that lists all pages in the current
replay session. Blue arrows indicate pages that can be viewed in BBR. Click the
blue arrow to view the associated page.
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If Tealeaf is configured to capture Ul Events, BBR can be configured to display
them in the Page List, marked with a Ul icon. Display of UI Events can be toggled.

Refresh List (Active sessions only)

This button is displayed only during replay of an active session. Click it to display
any new pages that the visitor has added to their session since the last time you
loaded or refreshed the page list.

Hide
This button collapses the three panes on the left sidebar. To open them, select View
> Show > Sidebar.

Overlays menu
If IBM Tealeaf cxOverstat is licensed and Tealeaf is capturing data, the Overlays
menu is available.

Note: IBM Tealeaf cxOverstat is a separately licensable product that is used to
monitor usability aspects of your web application. please contact your IBM Tealeaf
representative.

Note: The Overlays menu may not be available for all BBR sessions.

Annotations
Click to add annotations to the current page.

Start Replay

Switches to the Content pane and begins an automatic playback of the session
from the page that is currently selected in the Navigation pane, timed to match the
original visitor's view times.

When you start replay, you can choose to replay the session as it was captured
(Auto) or to delay each page a preset number of seconds:

Page Delay Time

o

Auto (as captured)
) |3 second(s) per page

= 50

Figure 23. Page Delay Time

* When set to Auto, replay accurately reflects how long the visitor waited between
completing recorded actions on the site.

To begin replay, click Start. The label on the toolbar button changes to Stop
Replay, and a timer is displayed to the left of the button to count down the
seconds between each hit in the recorded session.

Previous / Next

Steps backward or forward through the navigation list, displaying the replay;,
request, or response view in the Content pane, depending on the currently selected
view.
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Close Session
Ends the current BBR session and closes the browser window.

Content Pane
This pane displays the replayed hit, the request headers sent from the visitor's
browser to the website server, or the raw HTML of the response that is sent from
the website server to the visitor's browser.
* To change the content pane, click the Replay, Request, or Response button in the
toolbar.

Search enfire store

~ -5 : -)
b&P btrauss & 1' lesser

1573 :'|—';_-|'|.- yonds Since 1872

Furniture Electronics  Apparel

F Series pre—. Yo

‘H‘ln

b - Yo

; .

AHES!IH#I” \

.
frie

Limited Offer 20% OFF 20% Off All Sony Vaio F-Series

'.:— :} FREE SHIPPING on orders over $50.

“‘l & hisofferis valid on ail our store items
L oo

1!

Buy Canon REEEL

Starting at 5499

Best Selling Products

Sony WA Nine Wast Wiomen's

AEIL ) 111" Lucerg Purmng
Jl. l:Ll.u.| F -
See &l Ghoes

* If highlighting is enabled, the modified form fields and selected links are
highlighted in green on the page in Replay view.

* When Replay Shield is enabled, your mouse-driven interactions with the
Content pane are disabled, which prevents accidental execution of any JavaScript
that might be triggered.

y9 E R

Figure 24. Content Pane

User Agent Information Bar
If IBM Tealeaf CX Mobile is licensed, user agent information can be inserted in a
title bar above the replay pane.
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Just above the content pane, you can review any available information that Tealeaf
has detected and extracted from the user agent string that is submitted by the
visitor's device to the web server that delivered the session.

Note: This information is available only if the IBM Tealeaf CX Mobile module is
licensed and properly configured.

A user agent is any device that is used to browse a web application. Most user
agents self-report a unique string that identifies the exact brand and model of the
device. This string is used to query a public standard for additional information
about the device.

In the table below, you can review the content of each field, its source, and how it
can be accessed.

Table 3. User Agent Information Bar

Item Source Request Field Description

Browser TLT_BROWSER Visitor browser type

e This value is also available in the
Tealeaf System Hit Attribute

Browser.
Browser TLT_BROWSER_PLATFORM The mobile device platform
Platform
Best TLT_BROWSER_VERSION The X.0 version of the browser
RepTlayed
Using
Traffic TLT_TRAFFIC_TYPE The type of traffic, as identified by
Type extended user agent parsing

* This data is also captured in the

Traffic Type dimension.
Replay The type of renderer that is used by
Renderer Replay Server to render the session

¢ The type of renderer is determined
by the configured renderer types
and the browser from which the
session was originally experienced.

Display
You can display session data in various views. Replay view shows the web page
display as seen by the visitor. Request and Response views show the request and
response interactions between the browser and Web server. You can use Load Page
Details to review individual objects.

Replay View
In Replay view, the web page is displayed as seen by the visitor.

Note: In Replay view, interactions with screen objects in the session that are
interactive on the origin web application are forbidden. This restriction limits
unwanted interactions and tracking by the source web application.

* Next to the Start Replay button, you can see a counter of the number of seconds
before the page is advanced to the next one, and the Content pane is updated.

If UI Capture is enabled, the display of Ul events in Replay view can be toggled.
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* To avoid confusion, Ul events are always displayed in Request and Response
views. See "BBR Options" in the IBM Tealeaf cxImpact User Manual.

* For more information about UI Capture, see "UI Capture for Ajax Quick Start
Guide" in the IBM Tealeaf Ul Capture for Ajax Quick Start Guide.

If you license and enabled the IBM Tealeaf CX Mobile module, BBR supports the
replay of user interface events that are captured from the visitor's mobile browser.

Note: The IBM Tealeaf CX Mobile module is a separately licensed module of the
IBM Tealeaf CX platform. please contact your IBM Tealeaf representative.

* For more information about enabling, see "Overview of CX Mobile" in the IBM
Tealeaf CX Mobile User Manual.

* For more information about data that is acquired from mobile devices, see
"Overview of CX Mobile" in the IBM Tealeaf CX Mobile User Manual.

* See "Search and Replay for Mobile Web" in the IBM Tealeaf CX Mobile User
Manual.

¢ For more information about IBM Tealeaf CX Mobile, see "Tealeaf CX Mobile User
Manual" in the IBM Tealeaf CX Mobile User Manual.

Replay view context menu:

In Replay view, the following commands are available in the right-click context
menu.

Command
Description

View Document Source
View the source code for the selected document of the current response.

View Element Source
View the source code for the element that is currently selected on the page.

Add Annotation
Add an annotation for the current selection.

Create New Event from selection...
When text is selected, this context menu command is available for creating
an event from the selected text. The Tealeaf Event Manager is
pre-populated with values to match the selected text.

Create New Hit Attribute from selection...
When text is selected, this context menu command is available for creating
a hit attribute that uses the selected text as the pattern to match. The
Tealeaf Event Manager is pre-populated with values to match this
selection.

Test Response Modify Rules
In Replay view, you can review and test the response modification rules
that are applied to the current page.

Examine Cookies...
Review the cookies that are stored for the current session, which you can
copy to the clipboard as needed.

Request View
In Request view, the Content pane displays the headers in the request that are sent
by the visitor's browser to the Web server.
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Step Attributes:

If you deploy one of the Tealeaf client frameworks to submit events from the client
application to Tealeaf, you can review the submitted messages through BBR
request view.

To access step attributes:
* At the top of the request pane, click Click here to view Step Attributes.

— If you do not have access to the Event Manager, you cannot create step
attributes.

* The raw JSON messages are displayed in the [RequestBody] section.
Request view context menu:

In Request view, the following commands are available in the right-click context
menu.

Note: Context menu commands are only available in Request view if some text is
selected.

Note: These options are available only if you have access to the Tealeaf Event
Manager. See "Tealeaf Event Manager" in the IBM Tealeaf Event Manager Manual.

Command
Description

Create New Event from selection...
When text is selected, this context menu command is available for creating
an event from the selected text. The Tealeaf Event Manager is
pre-populated with values to match the selected text. See "CX Browser
Based Replay" in the IBM Tealeaf cxImpact User Manual.

Create New Hit Attribute from selection...
When text is selected, this context menu command is available for creating
a hit attribute to match the selected text. The Hit Attributes tab of the
Tealeaf Event Manager is pre-populated with values to match this
selection. See "CX Browser Based Replay" in the IBM Tealeaf cxImpact User
Manual.

Create New Event from Step Attribute...
When IBM Tealeaf CX UI Capture for AJAX is deployed, you can create
events to detect the presence of data that is submitted in JSON messages
for capture by Tealeaf.
* Any required step attributes are automatically created for you.

* See "Step-Based Eventing" in the IBM Tealeaf Event Manager Manual.

Create New Step Attribute from...
When IBM Tealeaf CX Ul Capture for AJAX is deployed, you can create
attributes to capture data that is submitted in JSON messages for capture
by Tealeaf.

* See "Step-Based Eventing" in the IBM Tealeaf Event Manager Manual.

Remove Page from Replay based on request field
If needed, you can remove the displayed page from replay based on the
values in a request field. See “BBR Replay Rules” on page 86.
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Response View
In Response view, the raw HTML sent from the Web server to the visitor's browser
is displayed in the Content pane.

Response view context menu:

In Response view, the following commands are available in the right-click context
menu.

Note: Context menu commands are only available in Response view if some text is
selected.

Command
Description

Create New Event from selection...
When text is selected, this context menu command is available for creating
an event from the selected text. The Tealeaf Event Manager is
pre-populated with values to match the selected text.

Create New Hit Attribute from selection...
When text is selected, this context menu command is available for creating
a hit attribute to match the selected text. The Hit Attributes tab of the
Tealeaf Event Manager is pre-populated with values to match this
selection.

Create Response Modify Rule
You can create and review the response modification rules that are applied
to the current page. After the rule is applied, the Response Modify Rule is
applied and the session is reloaded.

Test Response Modify Rules
You can review and test the response modification rules that are applied to
the current page.

Page Load Details
You can review the individual objects that are referenced and loaded for a page
after session replay completes or interactively during session replay.

Reviewing page load details after session replay

To review the page load details for a page after Session Replay has completed:

1. From the navigation area, select the page for which you want to review the
load details.

2. From the menu option drop down list, select View > Page Load Details.
The Page Load Details window is displayed.

For a description of data that is displayed in the Page Load Details window,
see Working with the Page Load details window.

Reviewing page load details during session replay

To review page load details during session replay:
1. Load the session for viewing.

2. While the session is replaying, select Page Load Details from the Processing
window.

The Page Load Details window is displayed.
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For a description of data that is displayed in the Page Load Details window,
see Working with the Page Load details window.

Working with the Page Load details window

The time, in seconds, that it took to render the page is displayed at the top of the
Page Load Details window.

The Page Load Details window can be used to review all of the content that is
requested from an individual page and whether the replay client was successful in
loading it. It displays all of the requests to get the resources for a page. If a
resource fails to load, the page might not render correctly.

Having access to real-time PLD gives users insight into the workings of the HTTP
interactions (as it pertains to getting the resources for a page) that occur in the
client / server architecture. The details presented in the window are an account of
the interaction between the renderer and Replay Server or the Remote Host.

You can size the columns and scroll vertically and horizontally to optimize content
viewing.

If you are using a TLI Server, you can identify the objects in the page that were
retrieved from a TLI file. In the Source column, any entry that includes TLI
indicates that Replay Server either retrieved it from the TLI Server or from the TLI
cache that is maintained on the Replay Server. See "Managing Static Archives" in
the IBM Tealeaf cxImpact Administration Manual.

The column definitions for the Page Load details window are as follows:

Page A numeric identifier of the page that the customer navigated to during the
session.

The number corresponds to the page number that is displayed in the
Navigation panel in the BBR user interface.

Status Code
Indicates the load status of the page. Valid values are:
* Done
* Fail
Code Indicates the HTTP status code of the request.
Valid values are any standard HTTP status. For example, a status of 200

indicates the request has succeeded, while a status 404 indicates the page
was not found.

Load Time
The time in seconds that it took the resource to load and the content to be
received by the customer.

Content
The Content column specifies the MIME or Content-type of the content
received.

MIME is a standard identifier that indicates the type of data that a file
contains. For example, the content might be text/html, text/plain, or
text/javascript.

Method
Indicates the HTTP method type. This will almost always be GET or POST.
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Source
The source of the loaded page. Valid values include:

* Session

A value of Session indicates that the content that was found within the
session.

* RemoteHost

A value of RemoteHost indicates the content was not found within the
session, thus getting it from the original source.

e Info
A value of Info indicates the content is of an informative nature.

URL The content URL or resource URL.

Error Message
Displays the error message text for a page if an error was encountered.

Error code

Displays the code for the error message if an error was encountered.

You can right-click in the Page Load Details window to access operations from the
context menu.

Page Load Details context menu:

In the Load Details window, the following commands are available in the
right-click context menu.

Note: The available context menu commands may change depending on the
currently selected content in the Page Load Details window.

Table 4. Page Load Details - Context menu commands

Command Description

Host/Port Remap Using host/port remapping, you can redirect BBR to retrieve
content from a different host name and port from the origin
server. This feature prevents unnecessary retrieval from the origin
server during replay.

Copy URL to clipboard | This option allows you to copy the URL to your clipboard so you
can paste it elsewhere.

Open URL This option allows you to open the selected URL in a new
browser.
QueryData If the URL contains query parameters, they are listed as

name-value pairs in this sub-menu.

For example, if the URL was www.test.com/?type=JSON
&reload=false, then the sub-menu displayed would be:

type=JSON
reload=false

Request Headers Mouse-over to view name-value pairs in the header of the
request. Select one to open an edit window from which you can
copy values.

Response Headers Mouse-over to view name-value pairs in the header of the
response. Select one to open an edit window from which you can
copy values.

View Response Text When the selected object is an AMF hit, this option decodes the
binary object and displays it in text form in Notepad.exe.
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Table 4. Page Load Details - Context menu commands (continued)

Command Description

Add Block URL Rule Use this command to remove a resource. Sometimes resources are
not critical for the page to render correctly, and if the resource
impacts page load performance in a negative manner, you can use
this command to write a "Add block url rule".

Page Statistics
Just above the topic pane, you can review the statistics for the currently displayed

page.

Gen Time! 0,.008% Met Trip: 0.540s Round Trip: 0.5365 eLpanse Sizel 21,155 Status Code: 200

Figure 25. Page Statistics

Statistic
Description

Gen Time
Time that is required to generate the page, in seconds.

Net Trip
The time that is required to transmit the page across the network to the
visitor's browser, in seconds.

Round Trip
The time that is required to transmit both the request and the response, in
seconds.

Response Size
The size of the page that is delivered to the visitor (the response), in bytes.

Status Code
Any HTTP status code that is generated by the hit.

Navigation Pane

The Navigation pane displays the pages and their related sub-pages in the order in
which they were experienced by the visitor.

* If the Content pane is in Replay view, only the hits that can be visibly replayed
are displayed.

¢ If the Content pane is in Request or Response view, all hits are displayed.
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Figure 26. Navigation List
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The preceding image displays a partially expanded set of pages and sub-pages.

* The page or sub-page that is displayed in the content pane is highlighted in
blue.

* Next to some pages in the Navigation List, you may see carets to expand the
page. Click the caret to display the sub-pages for the selected page.

In the preceding image, you can see the Navigation List that is expanded to
display all of the available columns.

* As needed, you can click and drag the right side of pane to display additional
columns of information.

* A set of tools is available in the toolbar above the pane.

Navigation pane hierarchy

In the Page column, you can see how the pages are organized in a hierarchy. The
currently displayed page is highlighted. To display a page in the Content pane,
select it in the Navigation pane.

Right-click any entry in the Navigation pane to open a menu.

To see a full list of all pages in the session, click the Page List icon in the toolbar.
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Structure of hierarchy

Note: ScreenView nodes are visible only in Replay view.

* In Request and response view, Ul events are listed in physical order of

occurrence under a page.

+ Page
+ ScreenView
+ ScreenView
+ UI Event
+ UI Event
+ ScreenView
+ UI Event

Definitions

Table 5. Navigation pane hierarchy

Icon Term Description
Page A page is defined as any hit (request
D z and response pair) in which the

returned response is in a text-based
format, such as HTML, XML, or plain
text. If a page is not displayed during
replay, none of the underlying events
is displayed either. A page can be
hidden by replay rule, by
ReqCancelled failure, or by another
means. Redirect pages are not
displayed by BBR. The page number
is listed next to the icon. These
numbers can differ if the session is
fragmented.

¢ Pages that are numbered with two
dashes (--) can indicate UI hits,
pages that are served from a
caching server, or non-pages such
as redirects.

— Ul events are positioned beneath
the page where they were
detected.

* Pages that are followed by an
asterisk and a number in
parenthesis, for example *(110),
indicate that was a cached back
page was hit. The number in
parenthesis is the previous page
hit.

* If you want, you can display the
hit number, instead of the page
number, in the first column. To
toggle display of hit numbers,
select Options drop-down >
Options > Use Hit Numbers in
Navigation List.

— When the above is selected, hit
numbers are displayed for all
objects in Request and Response
view and only for pages in
Replay view.
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Table 5. Navigation pane hierarchy (continued)

Icon Term Description

I] o Page * The title of the Ul event provides
some information about the event

continued that occurred.

+ If the session is captured by using
a Logging Framework from IBM
Tealeaf CX Mobile for Mobile App,
there are no page numbers, as
sessions for mobile native
application sessions do not contain
viewable pages. Red text indicates
a hit that either returned an error,
such as HTTP 400+ or 500+, or a
request that the visitor canceled
before it completed loading.

Caret Click to display the sub-page that is
associated with this page.

e ScreenView A Tealeaf-specific term, a ScreenView
g is defined as a state or stage of a
single URL. Some web applications
can contain multiple sets of user
interaction objects that are referenced
from the same URL. For example, a
page on your web application may
contain multiple tabs, in each of
which the visitor performs separate
discrete actions. For tracking
purposes, you can group user actions
by the tab in which they occurred by
using the Tealeaf Screen Views.

* Screen Views are displayed in BBR
only. These subpages are not
available for display in RTV.

ScreenView tracking requires the
deployment of a Tealeaf client
framework. For more information:
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Table 5. Navigation pane hierarchy (continued)

Icon Term

Description

UI Event
i

A Ul event is any user interface event
that is captured from the visitor's
client by using one of the Tealeaf
client frameworks. For mobile native
and AJAX-based applications, for
example, some user interactions do
not generate a request and
corresponding response from the
server. Using Tealeaf client
frameworks, you can capture these
types of user interface events and
actions and submit them for capture
and processing to Tealeaf.

Note: Click events are fired after the
HTML for the rendered page is
stored. For the last click event on the
page, the click event can be delayed
until any configured UI custom
highlighting is applied.

Note: Orientationchange, touchstart,
touchend, and scroll UI Events do
not replay if you did not installed or
configured the CX Mobile licence.

Although they are present in the
session data, events of the following
types are not displayed in the
Navigation List:

* Joad, unload, attention, scroll,
and resize.

* ClientState events that are
submitted from UI Capture

UI event tracking requires the

deployment of a Tealeaf client
framework. For more information:

Navigation pane columns

By default, the navigation pane is sized to show only some of the available
columns on the left side of the screen. As needed, you can click and drag the right
side of the navigation pane to display the other columns of information.

Column
Description

Page  The page and its associated subpages.

Title Title of the page as reported in the data

Time Stamp

The time stamp when the page was captured

Gen Time

The time that it took to generate the response

Net Trip

The network transit time to send the response
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Round Trip
The network transit time to send the request and return the response

Response Size
The size of the response in bytes

Status The HTTP status code for the response.

* A status code of 200 means that all is well
Navigation pane tools
The following tools are available in the Navigation pane toolbar.

Table 6. Navigation pane tools

Icon Tool Description

Page List Click to display the full list of pages in the
session, which additional details.

e See “Page List” on page 48.

Hide Click to hide the left navigation pane.

* To show the pane again, select Options
drop-down > Options > Show Sidebar.

m Filter By Click to select filtering options for the
Navigation pane, as they are specified in
Sub-Search.

Other panes
The following panes can also be displayed on the left side of BBR below the
Navigation pane.

* Events Pane
¢ Form Fields Pane

The options to toggle the display of the above panes are available through the
Options menu.

Navigation context menu
The following menu commands are available in the context menu for the
Navigation pane.

When you select a page or subpage in the Navigation pane, the following options
can be displayed:

Command
Description

Replay
Display selected page in Replay view.
Note: This option is not available in Request and Response view if the

selected page or subpage cannot be replayed.

Request
Display selected page in Request view.

Response
Display selected page in Response view.

For Tealeaf administrators, the following items are displayed in the context menu
accessible through the Navigation pane.
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Note: To configure replay rules, you must be a member of one of the following
admin groups:

* Admin Group

* cxReveal Admin

e cxView Admin

Using replay rules, you can apply changes to the content before it is displayed in
the screen. Replay rules can be used to remove pages from replay, suppress display
of replayed pages, and more.

Note: Replay rules that are configured in BBR are saved to the replay server,
where they are applied to all Tealeaf users during replay. These replay rules do not
apply to a specific user or to a specific session.

Tealeaf administrators can also configure replay rules by using the Portal
Management page.

* For more information about replay rules in general, see RealiTea Viewer - Replay
Rule.

Command
Description

Remove this page from replay
Marks the selected page to not be displayed in Replay view. While the
page is still displayed in the Navigation pane, it does not display replay.
To add the page back into replay, right-click the page after the one that is
removed in Navigation pane and select Delete rule which removes this
page from replay....

Delete rule which removes this page from replay...
If a replay rule is lied to the page to remove it from replay, you can this
option to revert the removal from replay.

Treat this page as Highlight Only
You can instruct BBR to treat this page as containing highlighting
information only. The previous page in the Navigation list is displayed,
and the content of the selected page is applied as highlighting to the page.

Treat this page as a Popup Page
You can create a replay rule that instructs BBR to treat this page as a
popup window. During replay, a popup window can interrupt the flow of
replay and can cause some page data to fail to display.

Add Custom UI Event Highlighting...
When a Ul Event entry is selected in the Navigation List, you can apply
custom highlighting to the selected element by specifying a JavaScript
function.

Open URL in browser
This option allows you to open the selected URL in a new browser.

Copy URL to clipboard
This option allows you to copy the URL to your clipboard so you can paste
it elsewhere.
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Events Pane
This pane displays a list of all events that are logged for the currently selected
page. Events are listed in the order of execution. It is only visible when the

Content pane is in Replay view.

F s
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E Event Occurrences in Session: 4
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Figure 27. Events Pane
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In the preceding image, you can see how event data is presented in the Event
pane.

For each line in an event listing:

Event (n) - This line identifies the sequence in the session when the event fired,
after which is listed the event name.

— The Icon: value indicates the file name of the icon that is displayed in session
lists and other reports for this event.

— You can display a chart that shows the counts of the event occurrences for
any day. Right-click the event entry and select Show Report.

Event Occurrences in Session (n) - Indicates the number of instances of the event
on the page.

Value[Type] (n) - The recorded value of the event, including an indicator of the
type of value recorded (Numeric or Text).

ReportGroup (n) - Parent node a report group that is associated with the event.
The number in parentheses is the report group identifier.

— The report group No Dimension Report Group is displayed as No Dimension
Report Group, and always has a report group index of 1.

- Fact(n)[Type] (n) - Indicates the fact into which the indicated value is
recorded. Multiple listings of the fact indicate that values were recorded more
than once.

- Beneath facts in report group other than No Dimension Report Group, you
can review the dimensions and their applicable values.

Event Reports

When an event is selected, you can optionally generate an event chart of the report
that is displayed in BBR. Right-click the event entry in the Events pane and select
Show Report.

—— )
D 11 Mag Http 500 - Intermnal Server Error
[€ 12 Mag 07/09/2012
13 Mag 7
[515 hittp B TIE
4 b Sl TH TN
44
5, 34
=9, Ewent: Http 500 - T
2
- Ewent Qcocurrences
14
i Malue[Count]: TLT: |_|
0

=03 ReportGroup: U
-3 Fact[Count]:

Figure 28. Event Chart

URL (Normalized): TLT$OT ||

The displayed chart shows the counts of the selected event for each hour of the
current day.

To change the size of the chart, click and drag from the lower-right corner of the
chart display.
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— To revert to the default size, minimize the chart and then expand it again
through the toolbar.

* To change the selected focus period, click the Calendar icon in the chart's
toolbar.

* You might specify a focus period that extends across multiple dates. Click the
start date, and then click the end date.

* You might also display data from a comparison range.
* To hide the report, click the Minimize icon in the toolbar.
* To close the report, click the X icon in the toolbar.

Form Fields Pane

Form Fields

Field Nare Yalue

| treo

Figure 29. Form Fields Pane

During replay, if the page displayed in the Content pane contains form fields, you
can review the form field names and the values that are entered by the visitor in
the Form Fields pane.

* Form field names are listed in alphabetical order.

* true/false values typically indicate that a check box or radio button was
selected or cleared.

* This pane is only visible when the Content pane is in Replay view.

Form Fields menu

The following commands are available in the menu when items are listed in the
Form Fields.

Command
Description

Search Completed Sessions
Search the available completed sessions for the form field name.

Create New Event from
Create an event that detects the form field name in the session data.
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Create New Hit Attribute from
Create a hit attribute that detects the form field name in the session data.
The Hit Attributes tab of the Tealeaf Event Manager is pre-populated with
values to match this item.

Session Statistics

o LAt Uae: 04162010 16:38:05  Pags |

Figure 30. Session Statistics

Along the bottom of the window is information about the session:

Statistic
Description

Session First Use
The first date and time stamp of the session.

Session Last Use
The last date and time stamp of the session.

Hit Count
The number of hits in the session.

Last Update
The date and time stamp of the last time that Browser Based Replay was
updated with session information, which is useful for identifying the
currency of your session data.

 For active sessions, this information updates when the page and
navigation lists are refreshed.

Tracking Interactions through BBR

As sessions are currently being experienced by visitors to your web application,
you can use Browser-Based Replay to track how they evolve in real time. You can
select the pages of active sessions like the pages of a completed session. As
needed, you can refresh the list of pages to see where the visitor is browsing in the
web application.

¢ In the Session List in the Portal, active sessions are denoted with a blue circle
marker in the leftmost column.

During replay, items that are displayed in the Events and Form Fields panes can be
highlighted in the session.

* You can also add annotations to active sessions.

Shadow Browsing Live Sessions

If needed, you can follow along in real time as a visitor explores the website. This
"shadow browsing" feature enables close support of your customers and the
tracking of activities that are otherwise causing problems with the web application.

Note: Shadow browsing applies to active sessions only.
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Figure 31. Refresh List

* To update the list of session pages through Browser-Based Replay, click the

Refresh icon (. )- Results of the refresh are displayed so that you can monitor
the changes in the page list.

* During replay, active sessions are automatically refreshed every 60 seconds.

Replay Highlighting

During replay, you can monitor the visitor's clicked or entered data.

When replay highlighting is enabled, the elements that the visitor interacted with
are highlighted by a green border in Browser Based Replay.

Each type 4 message corresponds to a user action such as a click on a button or
text change in a text box.

Highlighting elements makes it easier to monitor and track clicked buttons,
selected links, and any form data entered by the web site visitor.

Replay highlighting and mobile gestures

Traditional highlighting in BBR is not supported for mobile gestures (typell
messages).
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Unlike type 4 messages, most type 11 messages do not contain Ul element
information related to user actions such as swiping or pinching, because those
actions are not performed on an element, but rather on an area of the mobile
device screen.

For several mobile gestures, Tealeaf collects data from the area of the mobile device
screen that the visitor interacts with, not on the underlying UI element. Because of
the fundamental difference in how mobile device users interact with your web site
or application, Tealeaf does not apply the traditional green highlight border to
indicate when a gesture occurred. Instead, Tealeaf represents Gestures from a
mobile device by displaying animated hand icons on the Replay view.

Note: Only Type 11 gestures are shown with the hand icons. If a Type 4 Ul event

is captured, and highlighting is enabled, Tealeaf uses the regular green border for
mobile sessions.

Adding Annotations

You can annotate specific pages during replay through BBR.

For example, if you are assisting a customer with a problem, you can mark the
page where the problem occurred for resolution by your web development team.

Any BBR user can add annotations.
Note: You cannot add annotations to a TLA session that you loaded into BBR.
To annotate a session page:

Note: You cannot add annotations to Ul events pages, which are inserted by the
Tealeaf IBM Tealeaf CX UI Capture for AJAX.

Note: After an annotation is added, it cannot be removed.
1. In BBR, select the page that you want to annotate.

2. In the toolbar, click the Annotations () icon.
3. The following dialog is displayed:

Chapter 6. cxImpact Browser Based Replay 69



Annotations x

Text duthor Time Stamp o
test annotation #1 A0CMIN 09/07/2010 12:03:43

Fest annotation #2

Figure 32. Add Annotations

4. To add an annotation:
a. Enter the text of the annotation in the textbox at the bottom of the dialog.

* You can select from preselected values by using the drop-down indicator
next to the textbox.

¢ Tealeaf administrators can configure the list of preselected values.
b. Then, click Add Annotation.

5. The annotation text, your Tealeaf user ID, and the Time Stamp when it was
added are displayed in the Annotations popup.

Annotations are stored with the session data as annotation text and the author of
the annotation, like they are displayed in the Annotations dialog.

You can search for annotations through the Tealeaf Portal.

Availability of Annotations through Search

After you add, edit, or delete an annotation, the session is queued for re-indexing.
When the session is re-indexed, changes to its annotations are now available for
search.

* If multiple changes are made to a single session, each change is queued. If
possible, the indexer re-indexes all changes at the same time.

Note: Depending on the length of the queue at the time annotation changes are
saved, it can take a few minutes before the changes are available through search of

completed sessions.

Note: Since annotations must be indexed for search, you cannot search for
annotations in active sessions.
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Locating Annotations

After you finish adding annotations, you can locate annotations in the session
through the Navigation panel, where a small yellow icon ( '..!) is displayed next to
the Title of any page that has been annotated.

* In the BBR toolbar, the Annotation button is also highlighted when you select
the page in theNavigation panel that contains the annotation.

Finding Search Results in BBR

If you load the session in Browser-Based Replay from a session list of search
results, you can identify the pages where search terms are found through
theNavigation panel. Next to the Title of pages that contains search hits is

displayed a small red flag icon ( )-

BBR Replay of Client User Interface Events

If you install and deploy the UI Capture JavaScripts into your web application,
Browser-Based Replay supports replay of client user interface events.

* UI Capture enables the capture of user interface events that occur on your
visitor's client browsers that would otherwise not be detected by Tealeaf. These
events are submitted to Tealeaf for capture, analysis, and replay. In BBR, replay
of client user interface events is managed by Replay Server, instead of your
browser. Replay Server renders the user interface event inside the browser
control on the server and then delivers the finished rendering to your browser
for display.

For example, suppose Ul Capture captures a client user interface event in which
the following actions occur:

1. User selects a drop-down menu. Menu is displayed.
2. User makes a selection from the menu.

In BBR, the captured Ul event is displayed as a static page in which the user
makes the selection from the menu.

Sub-Search in BBR

After you locate a session and opened it for replay in BBR, you can search the text
contents of the session to filter the displayed list of hits. Through Sub-Search, you
specify one or more search terms to examine text or specified fields in the request
of the session that is currently loaded in Browser Based Replay.

* Search terms can be strings or numeric values.

* For numeric values, ranged searches are supported.

When the Sub-Search is run, the Navigation List is filtered to display only the hits
in the session that match the Sub-Search criteria. Then, you can use theHit Details
window to further review the matches to locate the specific hit of interest.

¢ The maximum number of items or occurrences that are returned in a Sub-Search
is 10,000. There can be multiple items that are returned for an individual hit.

Searching for Sessions

Sub-Search operates only on sessions that are loaded into Browser Based Replay.
Before you begin, you must locate and replay a session.
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* For more information about loading a TLA session file directly into BBR, see
"Session menu" in the IBM Tealeaf cxImpact User Manual.

Defining a Sub-Search

To specify a Sub-Search of a session that is loaded in BBR, select Options >
Sub-Search. The following window is displayed.

Cparator: | OR b
¥  Full Response Taxt - WE purnp = r Match Case
r = | contains hud = [T Match Case
u = [cortans =] = [ Match Case
o  TT— . T ks
o = [contains =] = [T Match Case
r - m = [T Match Case
o = [containsg =] = [ Match Case

i | om | o |

Defining fields of a Sub-Search

1. To enable a search field, click the leftmost check box for a row, or make a
selection in the first column of options.

2. To specify a search field:
a. Specify the columns in the search field:

1) Column 1: Select a search location from the drop-down list. Depending
on the field you select, the Column 3 drop-down list is populated with
all available values in the session.

2) Column 2: Select the field operator. The available operators depend on
the type of location that is selected for Sub-Search.

3) Column 3: Enter or select the text string for which to search in the
available location, by using the specified operator.

* For text-only fields, you enter the value for which to search.

* For other fields, you select the value for which to search from the
drop-down list.

* Wildcards and regular expressions are not supported.

b. To match only items in the session data that match the search term exactly,
click the Match Case checkbox.

3. To add multiple search terms:
a. Specify the appropriate search operator in the drop-down in the upper-right
corner:

Operator
Description

OR Any match of the specified search terms yields a matching hit.

AND All of the specified search terms must occur on a hit to yield a
matching hit.

AND on same page
All of the specified search terms must occur on a single request or
response to yield a matching hit.

b. Click the checkbox next to the following row in list.
c. Specify each column for the search term, as described above.
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Executing the Search
To run the Sub-Search, click Filter.

* When the results are returned, the Navigation List is filtered to show only the
matching hits.

* To review the details of the matching hits, click Hit Details.

Note: If you receive a data retrieval error when you run your search or attempt to
review the hit details, the BBR session can time out. In the BBR window, select the
address bar and press ENTER to refresh the session. Your filter operation can now
work. If the issue persists, contact your Tealeaf administrator.

Available locations for Sub-Search

In Sub-Search, you can specify the following locations for which to search for the

specified string.

* This list includes more fields than the session's request fields that are indexed
for search.

Note: To filter the list, begin typing the name of the section in the request where
the field you want is located. For example, entering env in the textbox limits the
list to only the [env] fields of the request.

Location
Description

Full Response Text
Search the entire response of each hit for the specified text.

Note: You can use this search field to search for specific error conditions
that are emitted from your web server to the visitor. For example, you can
search for error messages that generated when Replay Server was unable
to properly render the page. Enter Error rendering this page! in this
textbox.

Request Text
Search the indexed fields in the request of each hit for the specified text.

A1l Text
Search all available name-value pairs in the request and response text of
each hit.

HitType
Selected field is listed in the [HitType] section of the request. This data is
gathered and generated by Tealeaf.

TLFID =
Available fields for an instance of an event and its associated dimension
values that are recorded in the hit.

appdata
Selected field is listed in the [appdata] section of the request. This data is
inserted by user-defined actions that are completed in the Windows
pipeline.

ExtendedUserAgent
Selected field is listed in the [ExtendedUserAgent] section of the request.
This data is inserted by the Tealeaf Reference session agent for user agent
detection.
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env Selected field is listed in the [env] section of the request. This data is
gathered and generated by Tealeaf.

iamie Selected field is listed in the [iamie] section of the request. This data is
gathered and generated by Tealeaf.

timestamp
Selected field is listed in the [timestamp] section of the request.

* This section contains timestamp information that is gathered and
generated by the IBM Tealeaf CX Passive Capture Application.

urlfield
Selected field is listed in the [urlfield] section of the request. This data is
gathered and generated by Tealeaf.

HTTP_* These values represent headers that are submitted from the client.

* Some headers can be submitted by the IBM Tealeaf CX UI Capture for
AJAX solution.

TRANSFER_ENCODING
The transfer encoding defines the encoding character set used by the web
server to generate the response.

Event data fields:

For each event that occurred in the session, you can search for the event
occurrence's value or for specific dimension values that are associated with the
event. The fields that contain event data available in Sub-Search correspond to
entries inserted into the request when an event occurs.

The request data is in the following format:

Example Field
Description

TLFID_375TLFactValue
The Tealeaf event with internal identifier 375 was recorded. This field
contains its recorded value.

TLFID_375/TLDiml
This field contains the plain-text value of dimension 1, recorded when
event 375 occurred.

TLFID_375/TLDimHashl
This field contains the hashed value of dimension 1, recorded when event
375 occurred.

* Hashed dimension fields are stored to enable search for dimension
values that are longer than 32 characters. This data is not user-readable.

Available operators
The following operators can be available to use to search the selected location for
the specified string.

Note: Depending on the type of data that is specified for the search term, some of
the following operators are not available.

Operator
Description

contains
Search location contains the specified string.
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does not contain
Search location does not contain the specified string.

matches
Search location matches the specified string.

does not match
Search location does not match the specified string.

less than/equal to
For numeric values, the search location contains at least one value that is
less than or equal to the specified numeric value.

greater than/equal to
For numeric values, the search location contains at least one value that is
greater than or equal to the specified numeric value.

between
For numeric values, the search location contains at least one value that is
between the two specified values.

Searching active sessions
Sub-Searches can be applied to active sessions. Limitations:

1. The search is applied only against the pages, ScreenViews, and Ul events that
are currently listed in the Navigation List.

Note: Before you define a Sub-Search against an active session, you must
refresh the list of pages by using the Refresh button in the toolbar.

2. Any actions that are not applied to a session until it is completed are not
searchable in the session. Events that are triggered on the Last Hit or End of
Session trigger cannot be displayed in an active session and are therefore not
searchable.

Filtered Results

After a Sub-Search is specified and run, the Navigation List is filtered to display
only the matching hits.
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Figure 33. Nav List before Sub-Search

[Fage|[  Title

Time Stamp

_"3 Home page OF /27,2002 10:33:26

: 35 Home page OF/27/2012 10:34:58 (

Figure 34. Nav List after Sub-Search
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Note: To refresh this list, you must re-execute the search.

Note: The filtered list is a flat list. ScreenViews and UI events can be included in

the list of hits.

You can use the Previous and Next icons in the toolbar above the main panel to
step through the filtered list of hits.

Navigation List toolbar
Table 8. Navigation List toolbar

Icon Title Description
Ijﬁ] Page List Opens the page list. See "Browser Based
Replay Interface" in the IBM Tealeaf
cxImpact User Manual.
Hide Hide the Navigation List panel.

* To re-display the Navigation List, select
View > Show > Sidebar. See "View
menu" in the IBM Tealeaf cxImpact User
Manual.




Table 8. Navigation List toolbar (continued)

Icon Title Description

m Filter By Filter the Navigation List by the item that
is selected in the drop-down. See “Filtering
the Navigation List.”

Filtering the Navigation List

The following options are available in the Filter By drop-down.
Option Description

All Pages menu
Show all pages in the Navigation List. This view is the default one.

Expand All Pages
Switch to All Pages view and expand all pages, Ul events, and screen
views in the Navigation List.

Collapse All Pages
Switch to All Pages view and collapse all pages, Ul events, and screen
views in the Navigation List.

Subsearch menu
Options pertaining to a filtered navigation list.

Search List
Show list of pages after the Subsearch filter is applied.

Hits Detail
Show details on the hits that match the filter conditions. See “Hit Details.”

Hit Details

In the Hit Details popup, you can review the details of the hits that match the

Sub-Search results.

* To jump to the occurrence, double-click the row in which it is listed. TheHit
Details window closes, and BBR displays the matching page, ScreenView, or Ul
event where the Sub-Search match occurs, in the current view: Request,
Response, or Replay.
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Sub-Search Hit Details. Matching occurrences found: 10000

Page | Location | Term
[ 5 $§§t”85t H  TLTSID=956E0250060F67413A504B1B6F7930ES
2 5 $§ft”35t H  TLTHID=BE18596184496471EE2EBAC1DERI4BDS
[ 5 .Rrjft"'e"‘t t  TLTUID=A13C5523FBS3ACIDTEI4FEGFZE0DE66E
[ 5 _P‘I_;xthESt tl TLT_URL=/store/defaultpage
[ 5 $§ft”35t t  TLT_SERVER=206.1869.17.1%
=l 5 _Rr:ftUESt tl TLT_HOST _MAME=www . straussandplessercom
B $:§t”85t 1 TLT_APPLICATION MAME=store
=l 5 _Rrg}?tuest tl HTTP_COOKIE=magento=fu3dlwdbzubmyxzvhuiZoc
[= 5 -Rr:ftUESt tl HTTP_COOKIE=magento=fu3slwdbzubrmyxzvhuizoc
[ 5 _P‘I_;xthESt tl HTTP_COOKIE=rmagento=fu3glwdbzubrmyxzvhuiZoc
[= 5 _Rrg}?tuest tl HTTP_COOKIE=magento=fu3dlwdbzubmyxzvhuiZoc
5 _Rrgft"'e"‘t t HTTP_SET_COOKIE=TLTHID=2F46F398527C105205
[ 5 $§§t”85t H  TLapiArrivalTimeEx=2008-07-15T19:58:41.9046542
[ 3 $§ft”35t H  ReqTTLB=0
% [

Figure 35. Hit Details of matching Sub-Search hits

Column
Description

Page  The page in the full session where the match was found
Note: Values of -1 in this column indicate that the page cannot be
displayed.

Location
The location in the hit where the match was found

Term  The search term that was found

78  IBM Tealeaf cxReveal: cxReveal User Manual



Context
The byte number in the request or response where the matching text was
found, followed by the contextual information that surrounds the matching
string

Note: You can use the text of the Context column to locate other sessions
with the same text pattern:

1. Highlight the text of interest. Do not highlight the byte number.
2. To copy the text, press CTRL + C. The text is copied.

3. To go to the Search page, select Search > Completed Sessions from the
Portal menu.

4. Paste the text into the appropriate field.
* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Hit Details context menu:

The following menu commands are available in the context menu from the Hit
Details window.

When you select a page in the Hit Details window, the following options may be
displayed:

Command
Description

Replay
Display selected page in Replay view.

Request
Display selected page in Request view.

Response
Display selected page in Response view.

For Tealeaf administrators, the following items can also be displayed in the context
menu.

Note: To configure replay rules, you must be a member of one of the following

admin groups:

» "CX User Administration" in the IBM Tealeaf cxImpact Administration Manual:
Admin Group

¢ "cxReveal User Administration” in the IBM Tealeaf cxReveal Administration
Manual: cxReveal Admin

* "cxView User Administration" in the IBM Tealeaf cxImpact Administration Manual:
cxView Admin

Using replay rules, you can apply changes to the content before it is displayed in
the screen. Replay rules can be used to remove pages from replay, suppress display
of replayed pages, and more.

Note: Replay rules that are configured in BBR are saved to the replay server,
where they are applied to all Tealeaf users during replay. These replay rules do not

apply to a specific user or to a specific session.

Tealeaf administrators can also configure replay rules through the Portal
Management page.
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Command
Description

Remove this page from replay
Marks the selected page to not be displayed in Replay view. While the
page is still displayed in theHit Details window, it does not appear during
replay.
* To add the page back into replay, right-click the page after the one that
has been removed in the Hit Details window and select Delete rule
which removes this page from replay....

Treat this page as Highlight Only
You can create a replay rule that instructs BBR to treat this page as
containing highlighting information only. The previous page in the list is
displayed, and the content of the selected page is applied as highlighting
to the page.

Treat this page as a Popup Page
You can create a replay rule that instructs BBR to treat this page as a
popup window. During replay, a popup window can interrupt the flow of
replay and can cause some page data to fail to display.

Sub-Search in RTV

You can also complete searches within sessions through the IBM Tealeaf CX
RealiTea Viewer, the desktop client for searching and replaying sessions.

BBR Options

You can change view, replay, and interface options for Browser Based Replay.
Through the Options menu, you can configure the BBR interface and enable or
display BBR features.

* To open the Options menu, select the Options drop-down (-) in the BBR
toolbar.

Options Menu
Option Description

View menu

Page Load Details
View Page Load Details screen. See "Browser Based Replay Interface" in
the IBM Tealeaf cxImpact User Manual.

User Agent Info
Display user agent information for the session.
* A user agent is the entity that is used to contact your web application. In
most cases, the user agent is a web browser.

Processing logs
Displays the logs from the rendering engines that show the processing
being performed by the Replay Server.

This option is available to users with Admin authorization only.

Information in the Processing logs can help users diagnose and
troubleshoot problems related to the customer's session.
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For information about how to use real-time logging of Replay Server, see
"Using real-time page load logging information for session diagnostics” in
the IBM Tealeaf cxImpact Administration manual.

Full Page List
Opens the Page List.

Session menu

Note: The Session menu is not available if all of the underlying features
are separately disabled in BBR.

Note: The Session menu is not available if the current session was loaded
from a TLA file.

Send to Event Tester
Send the current session to the Event Tester.

* The Event Tester can be used to evaluate event definitions against
sessions that are found through search or uploaded to the server.

Send Link By Email
Opens a window for emailing a direct link to the BBR session. A message
can be included with the link.

* BBR replay links can be configured to last for a predefined number of
days.

Copy Link To Session
The direct link to the session is displayed in place of the toolbar. The X
button closes it and re-displays the toolbar.

View in RTV
Downloads the session for desktop viewing in the IBM Tealeaf CX RealiTea
Viewer.

* View in RTV is only available if the global logging level used by the
Portal application is set to 9 through TMS. If the global logging level is
not set to 9, you will not see this option in the menu.

Note: The RTV client must be installed on your local desktop.

Refresh Page List
(active sessions) Query the server for any updates to the Page List.

Download TLA
Download a BBR session as a TLA file. Save TLA will ask for Search Server
credentials to download the TLA.

Note: This option is only available if Advanced Options are enabled for

BBR for one or more groups to which you belong or if Logging Level 9 is
enabled.

Options menu
Contains the list of BBR options. A check mark to the left of an option
means that it is enabled.
This menu includes the following options.
* Show Sidebar
¢ Show Events
¢ Show Form Fields
e UI Events
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— Show All Ul Events
Only Show Last UI Events
Hide All UI Events
— Show ScreenView LOAD/UNLOAD
 Use Hit Number in Navigation List

¢ Use Default Page Name in List
— Show URL
— Show TLT_URL
— Show Page Title
* Merge Session Fragments
* Report JavaScript Errors
¢ Resize Replay Pane to Match Session

Note: This option is only enabled if you have an IBM Tealeaf CX Mobile
license.

 Edit Rules Profile
* Suggest Rules
Search Completed Sessions

Opens free text search of completed sessions. You can copy and paste text
from the Content pane to search in completed sessions.

Sub-Search
Search the displayed session for one or more strings.

Load TLA
Load a Tealeaf archive session file into BBR for replay. Replay rules are
applied during replay.

Note: TLA files that are loaded through BBR do not have On-Demand
Privacy rules that are applied to them and can pose a security risk if this
feature is enabled.

Note: This option is not available unless Advanced Options are enabled
for BBR for one or more groups to which you belong.

TLA files can be downloaded and saved through BBR, RTV, or the Event
Tester.

Close Session
Closes the current BBR session and the browser window.

Options Sub-Menu

The following options are available in Options menu > Options.
Option Description

Show Sidebar
Toggles display of the sidebar that contains the Navigation, Events, and
Form Fields panes.

Show Events
Toggles display of the Events pane.

¢ This pane can be displayed in Replay view only. See "Browser Based
Replay Interface" in the IBM Tealeaf cxImpact User Manual.
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Show Form Fields
Toggles display of the Form Fields pane.

¢ This pane can be displayed in Replay view only. See "Browser Based
Replay Interface" in the IBM Tealeaf cxImpact User Manual.

UI Events
If UI events are present in the session, this sub-menu contains display
options for them. See “Toggling Display of Ul Events” on page 84.

Enable Highlighting
Enables or disables form field and link highlighting, and also the
population of user input.

Use Hit Number in Navigation List
When enabled, hit numbers are displayed in the navigation list, and Ul
event hits, if present, are marked with the hit number, too.

* If this option is disabled, page numbers are used instead. Ul events are
not numbered.

* When fragment merging is enabled, hit numbers are prefaced by an
indicator as to which fragment the hit belongs. See “Merging Session
Fragment Overrides” on page 85.

Use Default Page Name in List
When enabled, select the default page name in the navigation list. You can
choose between Show URL, Show TLT_URL, and Show Page Title.

Merge Session Fragments
For completed sessions: refreshes the session, looking for session fragments
that may be part of the current session. See “Merging Session Fragment
Overrides” on page 85.

Report Javascript Errors
Displays errors that are produced by the page. If this option is disabled,
page errors are not displayed.

Resize Replay Pane to Match Session
When enabled, BBR automatically resizes the replay pane to match the
screen dimensions and positioning of the web client that is used by the
visitor. This option is enabled by default.

Note: This option is only enabled if you have an IBM Tealeaf CX Mobile
license.

Edit Rules Profile
You can use the Rules Profile Editor to view your list of existing rules. You
can add rules, delete rules, edit rules, rename rules, and view properties.
You can also edit the raw XML for the rules and view the rules history.

The Rules Profile Editor in Browser-Based Replay supports the following
rules:

* Host or Domain

* IgnoreURL

¢ PopupURL

* Host Remap

* Portal Remap

* Host Protocol

* ResponseMod

* HighlightonlyURL
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¢ Custom UI Highlight Rule

* BlockedURL

* PatchResponseWtihPostValue

* Whitelist Rule

* Mobile Mod Rule

* IgnoreReqVar for Matching URL

Suggest Rules
When enabled, you can view and apply suggested rules for a Microsoft
AJAX-based session.

Toggling Display of Ul Events
If UI events are present in the replayed session, then the Ul Events sub-menu
contains the following options:

Note: If you disable the display of Ul events in Browser-Based Replay, you must
log out of the Portal and login again to be able to re-enable them.

Note: In UI event hits, all of the important data is stored in the request, and the
response is irrelevant to replay. For Ul event hits in which the reported status code
can cause problems in replay, BBR treats the page as Status Code 200, which
indicates that all is well. For example, if the TealeafTarget page reports a Status
Code 404 (Not Found) error, BBR treats the page as a Status Code 200, which
allows replay to continue despite an issue with a page that is not ever replayable.
The true status code value reported from the server is stored in the [env] section
of the request.

Option Description

Show All UI Events
(Replay view only) Display Ul events in the Navigation list.

* To avoid confusion, UI events are always displayed in Request view or
Response view.

Note: To capture Ul events, Tealeaf Ul Capture must be implemented in
your environment. See "UI Capture for Ajax Guide" in the IBM Tealeaf Ul
Capture for AJAX Guide.

Only Show Last UI Event
For each page, show only the last UI event in the Navigation list. When
the Ul event is selected, the page is displayed, and all previous Ul events
for the page are applied to it to generate the final page rendering.

Hide All UI Events
(Replay view only) Display Ul events in the Navigation list.
* To avoid confusion, UI events are always displayed in Request view or
Response view.
Show ScreenView LOAD/UNLOAD
(Replay view only) Display Ul events in the Navigation list.

* To avoid confusion, UI events are always displayed in Request view or
Response view.
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Merging Session Fragment Overrides

Ideally, a session is stored in a single Canister file on a single server. However,
session timeouts, data storage, and other factors can contribute to the
fragmentation of sessions, in which the entire session is stored in multiple files in
multiple locations.

Note: These settings override the default Replay Server behaviors and apply only
to the current session being replayed in BBR. They are not retained from replay to
replay. As a result, replay behaviors can vary between BBR and RTV.

The Replay Server can be configured to automatically merge fragments of a
requested session into a single session for replay. When configured to do so, the
Replay Server acquires all fragments of a session from a set of selected Canisters
within a specified time range. This range is specified as a number of hours before
to a number of hours after the main session fragment.

Through BBR, you can specify new settings for the merging of session fragments

for the session that is currently loaded in BBR.

* To merge session fragments, select Options > Advanced > Merge Session
Fragments from the drop-down menu. The following dialog is displayed,
containing the current merge session fragment settings, which you can override

for the current session:

Merge Session Fragments

¥ Merge Session Fragments

Sezszion Merge Timespan Radius (Hours):

Sezzjon Merge Search Servers:

SELECTARCHS

[ All Servers

2

| oK

| Cancel

Figure 36. Merge Session Fragments

Setting Description

Merge Session Fragments

Enable or disable merging of session fragments for the current session.
When enabled, the following settings are applied to the current session

only.

Note: To restore the default settings, reload the session.
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Session Merge Timespan Radius (Hours)
Specify the number of hours in front of and behind the selected session
fragment in which to search for other fragments in the session.

Session Merge Search Servers
Select the servers across which search server searches to find and
assemble session fragments into a complete session.

— To search across all currently available servers, click the All Servers
check box.

Note: When the merging of session fragments is enabled, the request is submitted
to Search Server, which attempts to fulfill it by gathering the requested fragments.
In situations where Search Server is unable to gather the session information, it
returns the main session fragment, which enables partial replay of the session. No
session information is available for the fragment.

The default options for merging fragments can be configured through the Portal.

Merging session fragments is enabled and disabled for users at the group level.

Configuring BBR Replay Rules

Tealeaf administrators can configure the replay rules that are applied to
Browser-Based Replay through the Managing Tealeaf Servers page.

* See "BBR Replay Rules" in the IBM Tealeaf cxImpact User Manual.

BBR Replay Rules

86

To enable the highest fidelity replay without impacting the origin server or servers
of your web application, you can configure and deploy replay rules.

A replay rule is a modification to the session data during replay so that the replay
looks as close as possible to the original experience of your web application's
visitor. For example:

* The captured session data can contain references to a server that is not available
from where Tealeaf users are replaying the session. So, you must configure a
replay rule to modify URLs pointing to the origin server to point to a different
server.

* If the session is from an application that requires authentication, an
unauthenticated Tealeaf user can generate a significant number of Status Code
401 - Access Denied errors during replay. Using a replay rule, you can instruct
BBR to ignore or remove these pages during replay.

* The session can reference an external JavaScript file, which you may or may not
want to reference during replay. You can configure replay rules to suppress the
JavaScript file or to modify it so that it works effectively during session replay.

There are many more uses for replay rules. In the sections below, you can review
the replay rules that can be configured through the Replay Server to be applied to
all Browser Based Replay sessions.

Note: Replay rules do not change the stored session data. They are applied only
during replay by the Replay Server to the data that is passed to Browser Based
Replay for display to the Tealeaf user.
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Note: The quality of session replay is dependent upon the nature of the web
application. Websites that employ sophisticated display technologies or rely on
client user interaction events can require significant customization of the common
replay profile and replay rules.

Overview
Replay rules that apply to BBR can be configured in the following locations:

1. Replay Server: Through the Portal Management page, you can select the master
Replay Server and configure replay rules through the GUIL Changes to the
replay rules from the master Replay Server are automatically forwarded to any
slave Replay Servers, so that all servers are using the same set of rules.

2. Browser-Based Replay: When you have a session that is loaded into BBR, you
can use the context menus to create replay rules that are based on specific,
highlighted data in the currently loaded session.

3. IBM Tealeaf CX RealiTea Viewer: If you must configure replay rules that are
not supported through the BBR or Replay Server interfaces, you can download
and install the IBM Tealeaf CX RealiTea Viewer desktop application, which can
be used to search and replay sessions from your local desktop. When changes
are made to replay rules through RTV, they can be synchronized with the BBR
replay rule set.

4. Configuration File: For Tealeaf users who are comfortable working with XML,
you can configure replay rules in the native XML format by accessing the
configuration file on the master Replay Server.

Note: Tealeaf does not recommend configuring replay rules through the XML
file, as no data validation is completed on the edited file. Where possible, use
the user interface methods for configuring replay rules.

Required Access

Note: To create or modify replay rules for BBR, you must have access to the Portal
Management page (Tealeaf > Portal Management in the Portal menu). For more
information, contact your Tealeaf administrator.

Although it is not recommended, you can configure replay rules in XML format by
using the configuration file that is available on the Replay Server.

You must have command-line write permissions on the server that hosts the
Replay Server.

RTV

In many cases, the original replay rule was developed for use with the IBM Tealeaf
CX RealiTea Viewer. RTV is a desktop application for locating and replaying
sessions.

Many of the sections in the BBR replay rules area reference corresponding content
in the Realitea Viewer manual.

Replay Rule Types

Tealeaf supports the following types of replay rules.

In the table below, you can determine whether the rule is supported for
configuration through the Replay Server, BBR, or RTV.
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* Links are provided to additional documentation on each replay rule type. In
some cases, the best documentation is available in the "RealiTea Viewer (RTV)
User Manual" in the IBM Tealeaf RealiTea Viewer User Manual.

Table 9. Replay Rule Types

Rule Name

XML Node

Description

Popup Page

PopupURL

PopupURL marks pages as popup, so
they are not used for highlighting.

This rule is available in the BBR Rule
Profile Editor.

Remove this page from Replay

You can create a regular expression to
match URLs that you do not wish to
display in the Navigable Pages List or
during replay.

HighlightonlyURL

HighTightOnlyUrl

For AJAX-based pages, you can
configure a page to apply highlighting
only to the content retained from the
previous page. In this manner, you
can simulate the application and the
capture of Ul events.

This rule is available in the BBR Rule
Profile Editor.

Ignore ReqVar for URL Match

IgnoreReqVarForURLMatch

During replay, the replay client
attempts to match requests to
responses in the session data. In some
cases, you can improve matching by
providing a URL pattern, which is
used to remove request variables,
such as timestamp information, from
the set that is used to match the
request to the response.

This rule is available in the BBR Rule
Profile Editor.

ResponseMod

ResponseModi fy

ResponseModify rules are used to
complete special modifications to the
response to enhance the replay that is
displayed to the Tealeaf user. For
example, you can configure a
ResponseModify rule to disable
JavaScript used to break their pages
out of frames.

This rule is available in the BBR Rule
Profile Editor.

External File Modification

ExternFileModify

ExternFileModify rules can be
configured to complete additional
processing to external files that can
interfere with replay.

This rule is available in the BBR Rule
Profile Editor.
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Table 9. Replay Rule Types (continued)

Rule Name

XML Node

Description

Dynamic Response Modification Rules

DynResponseMod

When replaying a session that
includes data that is delivered from a
third party, the contents from the
third party must be associated with a
specific request. If the third-party
content is required to accurately
represent the customer's experience, a
dynamic response modification rule
must be configured to acquire the
content at replay time.

Dynamic External File Modification
Rules

DynExternalFileMod

If the main page loaded into RTV
references a separate file that is not
part of the session, the file may
require modification before it is
loaded into RTV. For example, if a
JavaScript file referenced by a page in
a session contains a domain reference,
that reference can result in a
JavaScript error during replay. You
can design dynamic external file
modification rules to apply to the
referenced JavaScript file that modify
the file before it is loaded into RTV.

Remove this page from Replay

IgnoreURL

IgnoreURL removes pages that should
not be replayable from the Viewable
Pages list.

This rule is available in the BBR Rule
Profile Editor.

Host Remap

RemapHost

RemapHost remaps the host that is
named in the HostProfile node to
some other host. For example, you
can use this mapping to replay
session data from a backup server,
instead of the origin server, which can
impact usage metrics.

This rule is available in the BBR Rule
Profile Editor.

Portal Remap

RemapPort

RemapPort remaps the port number
of the host that is named in the
HostProfile node to some other port
number.

This rule is available in the BBR Rule
Profile Editor.

Host Protocol

Protocol

Protocol forces the protocol to a
specific value: auto, http, https.

This rule is available in the BBR Rule
Profile Editor.

Frame Rule

FrameRule

FrameRule is used to force a URL to
alway load into particular frame
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Table 9. Replay Rule Types (continued)

Rule Name XML Node Description

BlockedURL BlockRemoteURL If needed, you can specify a URL or
set of URLs that are prevented from
reaching out to the origin server. If
the replay client is unable to locate
the response in the session data, no
effort is made to reach the origin
server for the missing content.

This rule is available in the BBR Rule
Profile Editor.

New Host HostProfile Add a host to monitor. The name of
the host must be the full domain
name of it (for example,
www.example.com. Each host has its
own set of profile rules, so you must
add or copy rules from any existing
host to the new one.

This rule is available in the BBR Rule
Profile Editor.

Whitelist Rule whitelistName By default, the Replay Server operates
in Blacklist mode, in which all URLs
are permitted to contact the origin
server. In many environments, this
ability to touch the origin server
during replay is not desirable or even
permitted. In Whitelist mode, you can
configure URL patterns that are
permitted to contact the origin server,
and all other URLs are blocked.

This rule is available in the BBR Rule
Profile Editor.

Custom UI Event Highlighting UIETementCustomHighlight Replay Rule for Ul Events: For the
selected Ul event, you can add or
modify custom highlighting rules.
These rules can be used when the
element being highlighted needs
special handling, such as calling a
javascript function for some custom
control. They can also be used for
debugging or alerting purposes when
specific user actions or values is
displayed in a session.

This rule is available in the BBR Rule
Profile Editor.

Ignoring UI Elements during Replay Replay Rule for UI Events Replay Rule for UI Events: You can
choose to ignore selected UI elements
during session replay. When this
option is selected, the following
dialog is pre-populated with the
regular expression pattern to identify
the UI element.
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Table 9. Replay Rule Types (continued)

Rule Name

XML Node

Description

Keystroke Breakouts

Replay Rule for UI Events

Replay Rule for UI Events: Ul
Capture supports the capture of
Intellisense keystrokes as Ul events.
Keystrokes applied with UI elements,
such as textboxes and form fields, are
bundled together into a single Ul
event for capture. To support
appropriate replay of the visitor
experience, RTV can be configured to
break out these aggregated keystroke
events into individual Ul events for
each keystroke. When keystrokes are
broken out in RTV, you can see the
characters that are displayed in the
order that the visitor entered them.

Remap URL

You can use the remapping URL
feature to remap the URL of content
external to the captured pages of a
session to a new destination.
Remapping URLs is commonly used
in situations where the external
content is not available or accessible
from the original site, and a copy is
made on another server to which you
can remap the URL.
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Table 9. Replay Rule Types (continued)

Rule Name XML Node Description

PatchResponseWithPostValue PatchResponseWith PostValue | This rule allows you to set up
patterns in the request, from which
values are grabbed. These values are
patched in the response. This work is
handled by the plug-ins, since the
type of the data can vary, and each
plug-in best knows its data type.

This rule has several attributes.

requestValue - Use this attribute for
query string values, or values where
the plug-in parses and 'flattens' the
request into name-value pairs. This is
a simple string match, not a regex.
Use this attribute or requestPattern,
not both.

requestPattern - Use this attribute for
request body values. This is a regex
pattern, which is used on the raw
request body as a whole. Use this
attribute or requestValue, not both.
When responsePattern is empty, this
pattern is used as the response
replacement pattern.

responsePattern (optional) - Use this
attribute when the response
replacement pattern needs to differ
from requestPattern.

You can also use this rule when a
value in a query string needs to be
patched into a jsonp response. The
responsePattern attribute is used to
specify what to replace in the
response.

This rule is available in the BBR Rule
Profile Editor.

MobileMod Rule MobileMod MobileMod Rule corrects the
dimensions of mobile devices that are
based on user agent information
during Replay.

This rule is available in the BBR Rule
Profile Editor.

Replay Rule Configuration through the Replay Server

The Replay Server supports the creation of a custom set of replay rules to apply to
BBR sessions. These rules are managed by the master Replay Server, which
publishes them on request to the other slave Replay Servers.

If you are deploying white lists in an environment with multiple Replay Servers,
additional configuration is required.
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Selecting Replay Rules to Modify

To modify replay rules for domains that are monitored by Tealeaf:
1. In the Portal menu, select Tealeaf > Portal Management.

2. The Portal Management page is displayed. In the left navigation panel, click the
Manage Servers link.

3. Select the master Replay Server.

Note: You can configure replay rules only on the master Replay Server, which
provides rules to all slave servers.

4. Click Rules in the toolbar. This option is available only for the master Replay
Server.

5. The Replay Rule Domains panel is displayed at the bottom of the screen.

¢ To add a domain, enter the domain in the space that is provided and click
Add. Use the following format for the domain name:

www.<domain_name>.com

* To edit the replay rules for an existing domain, select the domain, and click
the Edit link.

* To delete replay rules for a domain, select the domain, and click the Delete
link.

Editing replay rules
When you edit replay rules, you can populate new rules by using the following
commands.

* To add a rule, complete the appropriate properties and click Add.
e To delete a rule, click the Delete link next to its name.

* To load the properties from the rule into the appropriate textboxes for editing,
click the Load link. Saving a loaded rule replaces it.

The following replay rules can be configured through the Portal.

Note: When you enter URLs for replay rules, protocol identifiers, such as http://
or https://, are not needed. You can specify the protocol to use for all replay rules
or allow the Portal to resolve.

* Port identifiers such as :8080 and :443, are not applicable and must not be
entered.

Protocol
Select the Protocol in use from the drop-down. Set this value to Auto so that replay
server detects the appropriate protocol to use.

Ignored URLs

You can configure the Replay Server to ignore specific URLs during replay. URLs
matching the parameters that are specified here are not displayed during replay.

Property
Description

URL The URL to ignore. This value is concatenated with the value for the
domain to produce the full path to be ignored.

* The URL can include the wildcard character (*) to represent a pattern of
URLs, such as /home/*.
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Request variable
Optionally, you can specify a variable in the request with which to match a
URL. Matches of this variable are not replayed.

Request Variable Value
Optionally, you can specify a value for the Request variable in the request
with which to match a URL. Matches of this value are not replayed.

Highlight Only URLs
The Replay Server can be configured to highlight only the URLs that match the
parameters that are specified here.

Property
Description

URL The URL to be highlighted. This value is concatenated with the value for
the domain to produce the full path.

* The URL can include the wildcard character (*) to represent a pattern of
URLs, such as /home/=*.

Request variable
Optionally, you can specify a variable in the request with which to match a
URL. Matches of this variable are highlighted.

Request Variable Value
Optionally, you can specify a value for the Request variable in the request
with which to match a URL. Matches of this value are highlighted.

Custom Ul Event Actions
Through the Portal Management page, you can create and apply custom UI event
highlighting rules.

Property
Description

Element ID
Enter the identifier for the element on which to apply the custom
highlighting.

Script Copy and paste the script function into this textbox to apply to the selected
element identifier.

For more information about how to specify these rules, see “Custom UI Event
Highlighting” on page 100.

Host/Port Remapping
¢ To add a host to track, enter the host name in the Host textbox. Then, click Set.

e To map a port for the selected host, enter the port to map and then enter the
port to which it is mapped. Click Add.

Property
Description

Host  This host name is used instead of the host pulled from the domain of the
session. Since the host is used for the <base> to indicate the source of the
content, this value can be used to remap the content in the session to a site
other than the original site For example, if the original site is obscured by
proxies, this setting can be used to remap to a static, available resource. It
can also be used to map to an available server within the proxy from
which images and other content can be loaded.
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Port  The port to remap.

Maps To
The port to which remapped traffic is delivered.

Response Modification
If you want, you can modify content in the response by using simple
search-and-replace.

Property
Description

URL The URL whose response you want to modify.

Pattern
The pattern for which to search in the response. The pattern can be
specified as a regular expression.

* Special regular expression characters (such as ( or )) must be escaped by
using a backslash. For example:

\(

Replacement
The replacement text for the found pattern.

Replace
The occurrences for which to make the replacement.

White List Rules

By default, the Replay Server operates in Blacklist mode, in which all URLs are
permitted to contact the origin server. In many environments, this ability to touch
the origin server during replay can not be desirable or even permitted.

In Whitelist mode, you can configure URL patterns that are permitted to contact
the origin server, and all other URLs are blocked.

Note: Whitelist mode must be enabled in each Replay Server in your environment.

Whitelist and Blacklist mode rules apply only if the Replay Server is not able to
satisfy the request for content from its local cache of objects or from a TLI Server
that is deployed in your environment.

Regular expressions:

When you enable Whitelist mode for the Replay Server, you can specify the set of
URLs that are permitted to contact the origin server through the Portal
Management page. Using regular expressions, you can specify a set of URL
patterns that are permitted to query the origin server during replay. For the listed
URL or URLs, the Replay Server references the data that is stored on the origin
server during replay.

* The URLs that do not match the whitelist are effectively blacklisted, which can
be used to protect the source application from triggering web analytics metrics
and Tealeaf data counts, among other things.

Note: Poorly specified regular expressions can significantly affect server

performance. See "Regular Expressions in the RealiTea Viewer" in the IBM Tealeaf
RealiTea Viewer User Manual.
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Property
Description

Pattern
The pattern in URLs for the selected server. Matching URLs are permitted
to contact with the origin server. The pattern can be specified as a regular
expression.

* Special regular expression characters (such as ( or )) must be escaped by
using a backslash. For example:

\(

e If the pattern value is empty, the default pattern is used. This pattern
causes Replay Server to contact the origin server for image and static
content, which is not stored as part of the session data.

\.(ipg|ipeg|gif|css|is)$

Replay Rule Configuration in BBR

You can configure browser based replay rules in the navigation list, main panel,
load details, or Options Menu.

In Navigation List
Depending on the current selection in the Navigation List, you can apply the
following replay rules to the current page.

Context menu option
Description

Remove this page from replay
For more information about creating this type of rule, see related links at
the bottom.

Treat this page as Highlight Only
For more information about creating this type of rule, see related links at
the bottom.

Treat this page as a Popup Page
If needed, you can mark pages as popup pages so that BBR can adjust to
improve replay performance.

Add Custom UI Event Highlighting?
For more information about creating this type of rule, see related links at
the bottom.

Treat this page as a Popup Page:
A popup page is considered to be any page that the web application forces to be
rendered in a new browser window. During replay, BBR can have some difficulties

in displaying popup content, user interactions, and subsequent hits if it does not
know that specific pages are popup pages.
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Popup URL

iZreate a rule to mark URLs matching the specified pattern as a popup.
wildcards (%, are allowed.

\/storefindex . php/wishlist/ |

When this option is selected in the context menu, the URL of the current page is
automatically specified for you. As needed, you can use wildcards (* or ?) to
specify a set of URLs as popups.

Figure 37. Treat URL as a Popup Page

In Main Panel

You can configure replay rules through the context menus in BBR. In Request,
Response or Replay view, you can select an item, right-click, and select one of the
following options.

Option Description

Remove page from Replay based on request field
Based on a field included in the request, you can selectively remove the
page from display during replay.

Note: This selection is available only if text is selected in Request view.

Test Response Modify Rules
Through this dialog, you can review and test any response modify rules
that are applicable to the current page.

Note: This selection is available in Response view only.

UI Event Custom Highlight
When a Ul event is selected in the Navigation List, you can add or modify
custom highlighting rules to be applied to the user interface event.

Note: This selection is available through the context menu when you select
a Ul event in the Navigation List.

Host/Port Remapping
From the Load Details screen, you can configure host/port remapping
rules.

Removing pages from replay based on a request field:
Through BBR, you can choose to remove one or more pages that are based on the
URL pattern, request variable parameters, or both. By removing pages that are

based on request variables, you can significantly remove the replay experience.

Note: Pages that are removed from replay are not removed from the session data.
You can still search for and report on these pages.

Note: If your site responds to multiple HTTP_HOST values, you must manually edit
the profile to ensure that the ignore rule is correctly recorded against all

server_name values.
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For example, you can choose to remove from replay pages that are permanently
moved or are redirect pages, which are determined based on specific values for the
StatusCode request variable.

Note: This selection is available only if text is selected in Request view.

Remove Page from Replay based on Request Field

You are about to create a rule which removes from Replay pages containing
the request variable or urlfield listed, The walue is optional, and a matching
URL is optional, Wildcards(*,?) are allowed on the value and the URL.

Request variable name ( section/name):

lappdata | TLT_URL |

Request variable value {optional, blank for all):

|..-“st|:|r'e,-“in|:|ex.php,-’cnptirnnst |
LIRL:

|..-“st|:|r'e,-“in|:|ex.php,-’cnptirnnst

StatusCode=301 indicates a page is moved permanently. In the example, when the
URL matches /store/index.php/electronics/cellphones/ and the StatusCode
request variable in the [env] section is set to 301, then the page is removed from

replay.

Figure 38. Remove pages from replay based on a request field

In the preceding dialog, you can specificy exact values, and also patterns of values.

Parameter
Description

Request variable name
In these fields, you must specify the request variable section and variable
name on which to match pages for removal from BBR replay.

¢ The request variable section must be specified.
* Wildcards are not permitted.

Request variable value
For additional specification, you can enter a specific value for the request
variable on which to match. In the previous example, a request variable
value must be included, or all hits that contain StatusCode entries are

dropped from replay, which would remove all valid hits that are returned
from the web server.

* Specifying this parameter is optional. If it is not specified, all values are
matched.

* When you specify values, you can use the standard wildcards: ? to
replace a single character, and * to replace multiple characters.

URL You can use this field to specify whether the replay rule is applied to a

98 IBM Tealeaf cxReveal: cxReveal User Manual



specific URL or a pattern of URLs. If this value is not specified, the replay
rule is applied across the entire domain.

* Specifying this parameter is optional. If it is not specified, all values are
matched.

* When you specify values, you can use the standard wildcards: ? to
replace a single character, and * to replace multiple characters.

Testing BBR Response Modify rules:

Through BBR, you can review the Response Modify rules that are applied to the
current page and test them as needed by using the current hit as test data.

Note: This selection is available in Response view only.

Note: Through BBR, you can review rules only. Response Modification rules are
created through the Portal Management page.

Test Response Modify Rules

Rules &pplying to this page:
2 |
LRL:
|fstnre,-’index.phpfelectr1
—Test Results

Text Replacements:

1 Test

View Cuff..

In the Test Response Modify Rules dialog, you can review the number of rules that
are applied to current URL and then complete tests by using those rules and
review the test results.

Figure 39. Test Response Modify rules

To test applicable Response Modify rules:

If the Rules Applying to this Page count is greater than 0, you can:
1. In the Test Response Modify Rules dialog, click Test.

2. If changes are applied to the response based on the tested rules, the number of
changes is listed under Test Results.

* To view the modified response, click View.
+ To view a text-based diff display of the changes, click Diff....
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Custom UI Event Highlighting:

For the selected Ul event, you can add or modify custom highlighting rules. These
rules can be used when the selected element requires special handling, such as
calling a JavaScript function for a custom control. Custom highlighting rules can
also be used for debugging or alerting purposes when specific user actions or
values are displayed in a session.

Note: Custom UI event highlighting applies to Ul events captured from the
visitor's browser through UI Capture.

Option Description

Element ID
The element ID is pre-populated with the unique identifier for the selected
event through element ID or XPath.
* You can modify theElement ID field to use a regular expression, if
needed, for matching multiple elements.

function
In the dialog, you can specify the function that is evaluated by BBR for
purposes of highlighting this element. During evaluation, no setting of
values, highlighting or clicking is performed.

* Tealeaf provides a set of references that you can use in your JavaScript
function.

Note: Custom UI event highlighting works exactly like the RTV version.

In Load Details
When the Load Page Details screen is displayed, you can configure the following
rules from the context menu.

Host-Port Remapping:

You can configure BBR to pull static content that is referenced in the session data
from a different host, port, and protocol as needed.
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Host/Port Remapping b4

Hostname: =
| wwiw example.com EAl Add Hostname

o Remapping
g Remap Host to! Iwww.sxampie:.mm |

Rermap ports to:

From: To:

1 Page 1 of 1 (1 items)

“add Port | Remove Port
Protocol: I.ﬁ.lwa\rs http -I

Figure 40. Host/Port Remap

In the preceding screen, you can specify how host names and port numbers in the
session data are translated to other values. You can also specify an explicit
HTTP/HTTPS protocol to use.

Hostname: Select the host name from the list of available ones.

* To add a host name, click Add Hostname. Enter the host name in the form of
www.example.com.

* To complete no remapping for the selected host name, click the No Remapping
check box. This setting enables the remapping of port numbers and protocols
without redirecting to a new server.

* To remap the host to a different one, click the Remap Host to check box and
enter a new host name in the form of www.example2.com.

Remaps ports to: For the selected host name, you can remap ports that are
detected in the session data to new ports on the destination host.

¢ To add a port number to remap, click Add Port. Enter the port to remap from
and the port to which to remap. Click OK.

— To remap to the default HTTP port, set the remapped value to 0.

* To remove a port remapping, select it in the list and click Remove Port.

Protocol: For the selected host name, you can change the protocol to use when you
contact the remap host: Auto (default), Always http, or Always https.
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Host/Port remapping is also supported in replay through IBM Tealeaf CX RealiTea
Viewer.

Replay Rule Configuration in RTV

If you install the IBM Tealeaf CX RealiTea Viewer on your local desktop, you can
create replay during replay from data that is displayed in request or replay view.

Note: Replay rules that are created in RTV are applied to the local application only
by default. If you use RTV to create replay rules, you can choose to synchronize
your RTV replay rules with those rules maintained in the Replay Server for BBR.
See "Synching RTV Profile with BBR" in the IBM Tealeaf RealiTea Viewer User
Manual.

RTV can be configured to auto-suggest rules for AJAX-based replay.

Replay Rule Configuration File

Through the Replay Rules text file, you can use control host and port remapping,
custom page modification, and the fields in the session's requests that are used for
the URL, host name, and more.

* The RequestMapping node contains a standard set of entries that are found in the
session requests and rarely must be modified.

* For an example replay rule profile, see "Example Profile" in the IBM Tealeaf
RealiTea Viewer User Manual.

Note: Tealeaf recommends using the Portal Management page to configure BBR
replay rules, as some data validation is completed before rules are permitted to be
defined.

The replay configuration is an XML file in the following location on the Replay
Server:

<Tealeaf_install_directory>\System\ReplayServerProfile.xml

Host and port remapping and other custom page modifications are applied to
sessions based on their host names. For example, to customize sessions from
www.sample.com, the following node must be displayed in
ReplayServerProfile.xml:

<HostProfile name="www.sample.com">

Within the HostProfile node, the follow entries control remapping:
<!-- RemapMode values: off, on, null -->

<RemapMode value='on' />
<RemapHost value="www.sample2.com" />
<l-- There can be multiple RemapPort nodes -->

<RemapPort valueIn="49191" valueQut="80" />

RemapMode toggles remapping, or it remaps a host to a null host, which can always
return a 404 status code on any request.

* With RemapMode enabled, the RemapHost node specifies the host name to which to
remap.
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RemapPort is used to remap port numbers to other numbers. This value is needed
when images or other page elements are available on a port other than the port
number that appears in the captured data.

IgnoreURL specifies the URLs that must not be displayed in the NavList. It
supports the asterisk wildcard (x). In the following example, any URL matching
/path.axd with query parameters is ignored:

<IgnoreURL value="/path.axd?*" />

ResponseMod is used to apply regular expressions to response pages to alter them
as might be required for replay. For example, you might use it to disable a
JavaScript that forces a page to break from a FRAMESET if it finds itself in one.
The ResponseMod node has the following attributes:

<ResponseModify url=".x" pattern="top.location != Tocation"
replacementString="0" occurrences="first" id="7"/>

PopupURL Similar to IgnoreURL rules, PopupURL rules can be used to identify
popup pages. BBR includes these pages in the NavList and displays them in the
main replay window.

<PopupURL value="/path/popup.asp?*" id="3"/>

Note: PopupURL behavior is different in RTV. See "RealiTea Viewer - Profile
Options" in the IBM Tealeaf RealiTea Viewer User Manual.

ExternalFileModify These rules are used to modified external files that are
referenced in the response. In the following example, an external JavaScript file is
modified in order to change the value of this.fadeDuration from .8 to .001,
which causes the fade for the page to be much shorter.
<ExternalFileModify id="409"

url="/path/Details.js\?cache=.*"

pattern="this.fadeDuration = .8;"

replacementString="this.fadeDuration = .001;"
occurrences="all"/>

Special Rules
You can review rules that can be applied to manage special or unusual situations
in replay.

On-Demand Privacy: As needed, you can configure privacy rules to be applied to
sensitive data only during replay, which enables the original session to retain the
data for search and reporting purposes. These privacy rules can be configured to
block or mask sensitive data without affecting the stored session.

On-Demand Privacy rules are applied through Search Server.

Replay Rules and UI Capture: If you deploy IBM Tealeaf CX UI Capture for
AJAX by using the XML method of submitting client-side events, you must
configure special rules to make replay work effectively.

Note: If you deploy a Tealeaf client framework solution to capture interactions for

a Javascript-based or AJAX-based web application, you must develop and apply
replay rules.

Chapter 6. cxImpact Browser Based Replay 103



Disabling UI Capture: As needed, you can configure a replay rule to disable Ul
Capture during replay.

Step-based eventing

On the traditional, HTML-based web, user actions typically triggered a single
responding action from the web server. When you clicked a button, a form was
submitted. When you clicked a link, a new page was loaded. For applications built
on this framework, an individual event might occur only once per page.

In rich internet applications, however, this paradigm was altered. Many user
interactions on a page do not change the page itself. In fact, a user can complete
the same action of interest multiple times. For example, suppose that your web
application enables the entry of multiple addresses from a single form. When
Submit is clicked, the address data is submitted, and the form is cleared, enabling
another entry. In this case, the same event, SubmitAddress, can occur multiple times
on the same page. In Tealeaf, you want to be able to track all of these occurrences,
instead of just the first one.

Note: A primary usage for step-based eventing is to track events that may occur
multiple times on a single page.

Through step-based eventing, you can create Tealeaf events of these user interface
events that are generated by your rich internet application. In addition to creating
events from individual hits, you can also create events from steps, which are
individual user actions that are captured from the client application and submitted
to Tealeaf by using one of Tealeaf's client frameworks

* A step can be considered a "subhit” of a hit; a step reflects a discrete, trackable
user action, or a server-side action that does not result from a user action (such
as a redirect).

* Steps are captured by a client framework, which is bundled together, and

submitted as JSON messages to Tealeaf. These messages are then inserted into a
designated section of the request of the parent hit.

Step-based eventing enables the capture of multiple events from a single page of
your client application.

Note: Step-based eventing requires licensing, installation, and configuration of one
of the Tealeaf client frameworks, including IBM Tealeaf CX Ul Capture for AJAX,
IBM Tealeaf CX Mobile Android Logging Framework, and IBM Tealeaf CX Mobile
iOS Logging Framework. Beginning in Release 8.5, new versions these frameworks
are required to enable step-based eventing. For more information, contact Tealeaf
Professional Services.

Note: IBM Tealeaf CX Ul Capture for AJAX is only available to legacy users.

This information provides background information about client
framework-generated steps and step-based eventing.

Overview

An overview of step-based events, including prerequisites, limitations, message
types, and example messages.
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Pre-requisites

To create step-based events, the following components are required:

1. Tealeaf Release 8.5 or later

2. PCA Build 33xx. Tealeaf recommends using PCA Build 3330 at a minimum.

Note: Since PCA Build 3330, there were bug fixes and new features that can be
of interest to you, including the ability to capture IPv6 addresses and support
for new Linux platforms. See "Release Notes - PCA" in the IBM Tealeaf Release
Notes - Passive Capture Application.

You must be able to configure the capture of the application/json POST data
types through the IBM Tealeaf CX Passive Capture Application.

3. One or more of the Tealeaf capture solutions:

Table 10. Pre-Requisites

Solution Description Documentation

IBM Tealeaf |Used to capture client-side user "UI Capture for Ajax Guide" in the
CX Ul interface events for AJAX-based IBM Tealeaf UI Capture for Ajax Guide
Capture for |applications

AJAX

IBM Tealeaf |Used to capture client-side from "Tealeaf Android Logging Framework
CX Mobile | Android-based mobile native Reference Guide" in the IBM Tealeaf
Android applications Android Logging Framework Reference
Logging Guide

Framework

IBM Tealeaf |Used to capture client-side from "Tealeaf iOS Logging Framework

CX Mobile |iOS-based mobile native applications |Reference Guide" in the IBM Tealeaf
iOS Logging iOS Logging Framework Reference Guide
Framework

Limitations

The maximum length for selected values of text for attributes and events is 256
characters.

Sequence and distance events:

Note: Distance and Sequence events operate on hits, not steps. As a result, the
distance between events on multiple steps of the same hit evaluates to zero (0).

Technical definition

A step is defined as a specially formatted JSON message that is submitted by the

Tealeaf client frameworks to represent a session state of a form field.

* Step messages can contain any type of data. The data depends on the specific
client framework that is sending the message.

* A step contains Ul events from a single session only.

* In Tealeaf, these messages are submitted in JSON format and are not easy to
decipher in raw format.

Message types

Events that are captured from client frameworks are bundled together and
submitted as a set of messages. A message from a client framework is what defines
a single step in Tealeaf, which is a single event that is identified and captured by a
client framework.
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Multiple messages can represent a single action of the visitor. For example, clicking
a radio button might result in two messages of different types: one for the click
event and one for change event.

Note: If you do not want to double count actions, use both the event type AND
the ID/name when you create events for a specific action. If you look only for ID =
checkout method for example, then this event fires twice when you only wanted it
to fire once.

The volume of messages can depend on the configured logging level, which is
defined in the client frameworks.

Client Framework
Documentation

IBM Tealeaf CX UI Capture for AJAX
UI Capture does not support dynamic logging levels.

IBM Tealeaf CX Mobile Android Logging Framework
"Tealeaf Android Logging Framework Configuration File" in the IBM Tealeaf
Android Logging Framework Reference Guide

IBM Tealeaf CX Mobile iOS Logging Framework
"Tealeaf iOS Logging Framework Installation and Implementation” in the
IBM Tealeaf iOS Logging Framework Reference Guide

Example messages
You can review the raw format of a submitted set of JSON messages and the
format in which they are displayed after processing in Tealeaf.

Raw request body: The [RequestBody] following information includes a sample
raw request, which contains a set of JSON messages.

Note: In the raw request, the following entry is a single paragraph. You cannot use
this section to create step-based attributes.

* While it is possible to create hit attributes from the [RequestBody] section, it is
not recommended, as this format might change over time.
[RequestBody]
{"version":"0.0.0.4","serialNumber":1,"sessions": [{"id":"ID14H2M3S663R0.36228193
267311725","startTime":1326837723663, "timezoneOffset":480, "messages": [{"type":2,
"offset":2226,"count":1,"context":{"type":"LOAD","name":"root","renderTime":
2226}},{"type":6,"offset":2230,"count":2,"exception":{"description":"Unable to
get value of the property 'nodeValue': object is null or undefined",
"url":"http://straussandplesser.com/store/js/coremetrics/eluminate.js",
"Tine":1}},{"type":4,"offset":24878,"count":3,"event": {"type":"click"},"target":
{"id":"[['main'],['DIV',1],['DIV',0],['TABLE',0],['TR',0],['TD",0],['DIV',0],
[|P| ’0] ) [IAI ,G]] ll,ll.idTypeII:_z’lltypell:IIAII}}’
{"type":2,"offset":24880,"count":4,"context":{"type":"UNLOAD", "name":"root"}}]1}]}

After the messages were passed through Tealeaf, the raw request is stored in the
[RequestBody] section of the request, which is viewable through Request View in
BBR.

Formatted request body:

When the JSON messages are received, Tealeaf reformats them into a more legible
format, which is listed here.

* This information is available at the bottom of the request, which is formatted for
view in Request View in BBR.
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Click to view expanded example messages.

{
"version": "0.0.0.4",
"serialNumber": 1,
"sessions": [
{
"id": "ID14H2M3S663R0.36228193267311725",
"startTime": 1326837723663,
"timezoneOffset": 480,
"messages": [
{
"type": 2,
"offset": 2226,
"count": 1,
"context": {
IltypeII: IILOADII’
"name": "root",
"renderTime": 2226

"type": 6,

"offset": 2230,

"count": 2,

"exception": {
"description": "Unable to get value of the property
'nodeValue': object is null or undefined",
"url":"http://straussandplesser.com/store/js/
coremetrics/eluminate.js",
"Tine": 1

"type": 4,
"offset": 24878,
"count": 3,
"event": {

"type": "click"

"target": {
Il.idll:
"[['main'],['DIV',1],['DIV',0],['TABLE',0],
['TR',0],['TD",0],['DIV',0],['P',0],['A",0]]",
"idType": -2,
IltypeII: IIAII

"type": 2’
"offset": 24880,
"count": 4,
"context": {
“"type": "UNLOAD",
"name": "root"

}

In the preceding example, the content after the following string is a set of four
separate messages:
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"messages": [

Each message is demarcated by a set of curly brackets.

* Data that is defined at the same level as messages (such as serialNumber or
timezoneOffset) is considered environmental data.

Each step message constitutes a single step.
 Step-triggered events can fire per message step.

* In the preceding example, there are four-step messages. As a result,
step-triggered events can fire up to four times on this hit.

Note: Each step-triggered event also has access to the hit attribute data of its
parent hit and the environmental data included for reference in each step.

When you create step attributes, the value that is extracted is the contents between
the colon (:) and the final comma (,) on the line.

Suppose you want to monitor exception messages that are submitted from the
client framework. In the example above, the data is in the following area.

* In the following example, message data that was present in the previous
example but is not relevant to the example is replaced with the <omitted> string.
"sessions": [

{
<omitted>
"messages": [
<omitted>

{

"type": 6,

"offset": 2230,

"count": 2,

"exception": {
"description": "Unable to get value of the property
'nodeValue': object is null or undefined",
"url": "http://straussandplesser.com/store/js/

coremetrics/eluminate.js",

"Tine": 1

In the preceding example, you can see that the exception message is stored in the
description value. To reference this value in step-based eventing, when you create
the step attribute to monitor the above, the node in the tree is referenced by using
the following structure:

sessions[0] .message.exception.description

The naming structures for the sessions and messages nodes are changed, and the
type identifier is omitted.

Note: When you create step attributes through BBR, you use the menu, which
automatically pre-populates the attribute with the appropriate reference within the
Event Manager. These steps are described later.

Step-based objects

In Tealeaf, you can create two types of objects to monitor events that are captured
from a client framework and passed as messages to Tealeaf:

e Step attributes are hit attributes that acquire its data from a step. Step attributes
are specified in a slightly different manner but complete an identical function.
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e Step-based events are standard Tealeaf events that are configured to fire on one of
the steps triggers. As conditions, they can use any standard type of Tealeaf
condition, and also step attributes.

Default step objects
Tealeaf provides a number of step-based events and attributes for use in step-based
eventing.

* For more information about provided step attributes, see "Pattern Objects
Reference" in the IBM Tealeaf Event Manager Manual.

* For more information about provided step-based eventing, see "EES Reference -
Tealeaf Event Reference" in the IBM Tealeaf Event Manager Manual.

Step trigger types

To support step-based eventing, the Event Manager now provides two more
trigger types:
Trigger Description

Every Step
Event is evaluated with other events in each step.

After Every Step
Event is evaluated after every step is evaluated.

Note: This trigger is rarely used.
In the previous example, any event triggered to fire on Every Step is checked for
each combination of JSON message and environmental data. In the previous
example, any Every Step event is checked for the load, unload, exception, and

other data message.

Note: Step attributes are permitted to reference objects from the parent hit. As a
result, you can reference hit attributes in step events, but not vice versa.

In the event definition, the trigger can be selected from the Evaluate drop-down:

% Default

Every Step
after Every Step
after Every Hit
Last Hit

End of Session

autes

Figure 41. Available event triggers
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Available triggers are displayed in the order of evaluation. For a particular hit with
underlying steps, each Every Hit event is evaluated first, followed by each Every
Step event and After Every Step event. Then, the After Every Hit events are
evaluated.

Note: The events that fire on each trigger determine the availability of data. An
event can use data from any event that fired before the current event. In a
multi-hit session, the After Every Hit trigger fire on the previous hit before the
events configured to fire on Every Hit from the next hit. The same applies to
step-based triggers.

The order of firing is more accurately displayed as a nested structure:
* First Hit of Session
* Every Hit
* Every Step
* After Every Step
* After Every Hit
* Last Hit
* End of Session

Notes on using after every step trigger: In almost all cases, when you create step
attributes, you are interested in the current context of the session. You create
attributes to monitor the current data that is available as of the current step. As a
result, the After Every Step trigger is rarely used.

In the example below, the After Every Step trigger is used. This scenario mirrors
the After Every Hit trigger usage, except that it applies to steps instead of hits.

The After Every Step trigger is useful when you must compare the current state
with the previous state. For example, suppose you want to know whether users
clicked the same object twice in a row.

* To test this scenario, you must know both the object currently being click, and
the previously clicked object. If the events that track both the current and
previous states fire on the same trigger, they are updated at the same time and
therefore always have the same value.

* However, if the previous state event fires just after the current state value by
using the After Every Step trigger, the previous state event is not updated
when the current state event fires. Therefore, you can compare the current state
with the previous state by using an event that fires on the Every Step trigger.

Note: Form messages contain the currState and prevState properties within a
step. The currState property refers to the final value of the form field after
editing, and prevState refers to the default value before editing. These references
do not work for testing if the same action occurred twice, since the default value
can be reset to blank each time it is accessed.

Privacy
To manage blocking or masking of sensitive data, Tealeaf provides privacy
mechanisms to manage specific data before it is transmitted to Tealeaf.

Note: Application of privacy blocking or masking in the PCA or in the Windows
pipeline requires complex regular expressions, which can cause significant
performance degradation if improperly specified. Tealeaf strongly recommends
using the privacy solution that is provided with your client framework to manage
sensitive data.
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Replay
In Browser-Based Replay, steps are displayed as subpages to the main page on
which they occurred. Any triggered events are displayed beneath them.
* During replay, steps can be displayed in a more user-friendly format.

Note: Replay of step-based events in RTV is not supported.

Navigable Pages List

Through the request view of BBR, you can create hit attributes and events for
steps. When you load a session that contains [SON-based steps into BBR, the
Navigable Pages List looks like:
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Page =i

-- % 301 Moved Permanently
-- 301 Mowed Permanently

1 Home page
i -- UIEvent: 1 -4

2 Sony WAID VGN-THXNZ7HN/B 11
i -- UIEvent: 1 - 4

-- http:/fstraussandplesserncom,”

-- http:/fstraussandplesser.com,

3 Strauss and Plesser
n -- UIEvent: 1 - 4

4 Digital Cameras - Cameras - [
o -- UIEvent: 1 - 3

-- http:/fstraussandplesser.com,”

5 Strauss and Plesser
n -- UIEvent: 1 - 4

f Cameras - Electronics - Englis

7 Digital Cameras - Cameras -
n -- UIEvent: 1 - 3

-- http:/fstraussandplessercom,”

8 Strauss and Plesser (-
o -- UIEvent: 1 - 4

9 Zell Phones - Electronics - Enc
o -- UIEvent: 1 - 3

-- http:/fstraussandplesser.com
10 Strauss and Plesser

n - UIEwvent: 1 - 4
11 Digital Cameras - Cameras - |

- UIEvent: 1 - 3

J s HH'nl-"-"r+r=||rr=nr|n|nrrnrﬁnn:|;|
] | b

Figure 42. BBR Navigable Pages List

In the preceding image, the step that is captured from the visitor's user interface
are indicated by the UIEvent label. In the preceding example, each instance also
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lists the range of user interface events captured. UIEvent: 1 -4 indicates that the
specific step includes 4 individual user interface events.

Viewing formatted JSON messages
When one of the UlEvent steps is selected, you can review the JSON messages that
are submitted as part of the step.

Note: Any BBR user can view the formatted client framework messages. To create
attributes and events from them, you must have access permissions to the Tealeaf
Event Manager.

1. Click Request in the toolbar to display the request data.

2. Click one of the UIEvent entries in the Navigable Pages List.

3. The raw JSON messages are displayed in the [RequestBody] section.
4.

However, this information is not easy to read. To review the JSON messages in
a more legible format, click the Click here to view Step Attributes link at the
top of the request pane.

MNavigation Start Replay Previous Next Request Response Replay
Filter By Gen Time: 0.000 MNet T
Page Browser: Firefox Browser Platform: Win7
MEE! HOME jage Click here to view Step Attributes
| UlEwvent: 1 -5 [1amie]
Ui UlEwent: & - 12 TLTSID=7890B0FE382710380008DEIBCD3EE4T9
v [E2 Anashria Womens Premier Lea|| TLTHID=5092626E382B10388T0B3TFCOEST53856
i e TLTUID=7890B0F8382710380008DE1BCD3EE479

i UTEvenE: 6211 (E!IaptureﬁourcEfTeaLeafPassiveCapture2

Figure 43. Step Attributes link in BBR

5. The list of JSON messages are broken out into separate lines for easier reading.

* Each selectable item is a name-value pair that is highlighted when you move
your mouse over it.

* Null values can be selected for creation of step-based attributes.

* Hit and event objects that you create search for the values for the specified
JSON item.

Creating Step-Based Event Objects

You can create step attributes through Request view in Browser Based Replay.
Note: Creation of step attributes is not supported in RTV.

When you create objects through Browser Based Replay, the Event Manager checks
to see if the selected content is already referenced in an existing event object. If so,
the Event Manager selects that object for you to edit.

In some cases, the selected event object is provided by Tealeaf and is therefore not
editable. For example, Tealeaf provides the CUI Hit hit attribute, which references
the contents of the HTTP_X_TEALEAF request variable. When you choose to create
attributes or events from the values of this request variable, the Event Manager
selects the CUI Hit attribute for you to edit. This hit attribute cannot be edited.
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Note: If you want to create more step attributes and events from session data for
which attributes or events are already created, you must create them manually
through the Event Manager.

Note: There is a known issue in which the PCA fails to properly recognize UTF-8
encoding in data that is submitted from client frameworks, and the data can be
mangled in the stored session, causing issues in eventing and search.

Note: The following information applies to IBM Tealeaf version 9.0A only.

9.0A can properly recognize UTF-8 encoding in data that is submitted from client
frameworks.

Required access

Note: To create step attributes, you must have permissions to access the Tealeaf
Event Manager, where event-related objects are created in the Portal.

To test access, select Configure > Event Manager.

BBR step attribute context menu
To create a step attribute or event in BBR, right-click a name-value pair in the
formatted JSON message. The context menu is displayed:

* These items are disabled if you do not have access to the Event Manager.
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Figure 44. BBR Context Menu

Option Description

Create New Event from Step Attribute selection
Create a step-based event and any necessary hit attribute to gather the
data.

Create New Step Attribute from selection
Create a step attribute.

Creating a step attribute

When you select a JSON item in BBR and choose to create a step attribute, the
Event Manager is opened in the browser window currently opened to the Portal.
The following dialog is displayed:

Note: Depending on your browser type and configuration, you can manually
switch over to the Portal window.
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: Mobile Manufacturer

Marme Mobile Manufacturer

Description: Manufacturer of the mobile device
Active: v
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Search in: Request ;I

' Use Start Tag/End Tag
9 Use Text Pattern
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P Post-Match Operations

Case Sensitive: ¥
all Matches: v
Encoding: | UTF-8 _r|
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Figure 45. Creating a step attribute

Step attributes are commingled with hit attributes. They do not belong to a special
category. What defines an attribute as a step attribute are the properties that are

listed.

Table 11. Key Properties:

Attribute Properties

Description

Use Step Pattern

For step attributes, the Use Step Pattern radio button is selected for
you, which enables specification of the xpath to the node whose
value you want to track.

* When a step pattern is used to identify an attribute, the check is
completed by using a case-sensitive search by default. If you
choose to change the type of pattern tag to a step pattern, the
existing case-sensitive settings are preserved.
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Table 11. Key Properties: (continued)

Attribute Properties | Description

Step Attribute Path |The Step Attribute Path value contains the node information to
uniquely identify the JSON value to acquire in the attribute. For
the preceding example, the path is:

.sessions[0] .message.exception.description

This provides a unique path to the description value for the
exception message that was submitted from a client framework to
Tealeaf.

Note: You can complete the same Post-Match Operations on a step attribute that
you can complete on a hit attribute.

Data format: The values of step attributes are always treated as text patterns. As a
result, operators such as equals perform text-based comparisons, even if the
captured value is a numeric or Boolean value.

Data availability: Like the hits that contain them, steps are processed in isolation
from all other steps. For example, if you want to use data from step 1 for use on
step 2, you must create an event to record the data from step 1 for later use.

* Since each step is associated with a parent hit, any hit attributes triggered on the
parent hit are available for reference in each step of the hit.

* However, step attributes are available only within the single step that is being
evaluated.

 If you want to use a hit attribute in a step attribute, the event trigger must be
configured to be evaluated on one of the step triggers.

* Data from events that are triggered on previous steps is available in later steps.

Using data between step attributes: A step triggered event uses only data that is
contained in the step in which it is triggered, which is a similar behavior to how
hits are triggered. To use data from step 1 in step 2, you must record the data from
step 1 in an event and then reference the event in step 2.

For example, suppose your request data for a single hit looks like:

[appdata]
TLT_URL=/tealeaftarget.php
TLT_CUI_URL= /checkout

[StepAttributes]
{

||type||: 4,

"offset": 8063,

"count": 1,

"event": {
"type": "Change"

"target": {
"id": firstname",
"idType": -1,

IltypeII: IIINPUTII,
"dwell": 2196,
"currState": {

"value": "MyName"
1
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"type": 4,
"offset": 2293,

"count": 2,
"event": {
"type": "click"
'
"target": {
"id": "login:guest",

"type": "INPUT",

"subType": "radio",

"currState": {
"checked": true,
"value": "guest"

}
bs

In the preceding data:
» [appdata] data is available through standard hit attributes.
* There are 2-step messages:

— Step 1: The first step identifies the change client event, in which the firstname
form field is set to MyName.

— Step 2: The second step identifies the c1ick client event, in which the
login.guest element is set to guest.

A single step-triggered event cannot use data from both step 1 and step 2 at the
same time. For example, you cannot create a step-triggered event that fires on the
click message and records the value of the firstname value by using only step
attributes.

To capture the value of Step 1 based on the condition of Step 2, you must:
* Create a step attribute to capture firstname's value on Step 1.
* Create an event that records the value of the step attribute for Step 1.

* Create an event that fires on the click for guest and uses the value for the Step 1
event for the guest value.

Important notes on step-based eventing:

* A single web action can require multiple attributes and events to track. You can
create multiple attributes, which are inputs to a single compound event to track
a single user action.

Capturing a specific value:

By default, a step attribute captures all possible values for the selected JSON path.
When the attribute is specified, any value that is detected for the node becomes the
value for the attribute.

In some situations, you can gather in the step attribute only specified values. For
example, suppose that you are tracking the following JSON path:

.sessions[0] .message.clientState.event

By default, any step attribute can capture any instance of any value. So, your
attribute can capture values such as 1oad, attention, resize, or scroll. Suppose
that you are interested in creating a step attribute to track only the scroll values.
After you create the step attribute through BBR, you can complete the following
modifications to the attribute definition through the Event Manager.
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Edit the step attribute.

Click thePost Match Operations caret.
Select the User RegEx check box.

In the RegEx textbox, enter:

b~

scroll
5. To save the change, click Save Draft.

6. To commit the change, click Save Changes.

Now, the step attribute records only the instances of the scroll value for the
specified JSON path.

As an alternative, you can specify a step attribute without using the RegEx portion.
When you use the step attribute in an event, specify that the value of the step
attribute equals scroll.

Creating a step event
When you select a JSON item in BBR and choose to create an event, the Event
Manager is opened in the browser window currently opened to the Portal. The
Event Wizard is displayed.

Note: Depending on your browser type and configuration, you can manually
switch over to the Portal window.

The default event checks every step to see whether the JSON item is present and
records the last occurrence in the event by default. Using this configuration, you
can track the number of sessions in which the event occurred.

Note: If you cancel creation of a step-based event, you must revert the step
attribute, if created, through the Hit Attributes tab.

Triggers for step objects: Step-based events can be evaluated on the Every Step
and After Every Step trigger.

Triggers for compound events using step-based events as conditions:

Note: If you are creating an event with multiple conditions that uses one or more
step-based events, you must set the event to be evaluated on After Every Hit.
That trigger is evaluated after Every Hit, Every Step, and After Every Step, in
that order.

Tracked Occurrences for step events:

Note: For any event that is triggered off step-based data, you must configure it to
track occurrences at the individual hit level. Do not use session-level tracking, as

those options operate only on the first or last hit of the session.

Condition step: The Event Manager pre-populates the event definition with
properties to identify the specific JSON item to track.
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Figure 46. Creating a step-based event - Condition step

When you create an event to track a JSON message item, the step attribute that is
required to detect the name-value pair is also created in draft mode for you. In the
above, the Hit Attribute condition specifies the step attribute that the Event
Manager has also created for you.

Note: For step attribute conditions, Match Count and Last Value value tests are not
useful, as there is only one unique match and its value for a specified property on
the hit.

Note: If you do not want to double count actions, use both the event type and the
ID/name when you create events for a specific action.

* If you look only for ID = checkout method, then this event fires twice when you
only wanted it to fire once. Suppose you want to track clicked objects. Each
object has the event type click.

* To track clicks of a specific object, you must specify both the event type and
object ID.

* If a step attribute with the same properties exists, the Event Manager uses the
existing step attribute.

¢ As needed, you can add extra conditions to the event you are creating.

Table 12. Key Properties:

Attribute Properties | Description

Icon You must select an identifying icon for your step-based events.

Labels You can organize your step-based events into labels within the
Event Manager.

Evaluate Set the trigger to be either of the step-based triggers.

Track Set the occurrences to track to monitor the first or last occurrence

in the session or every occurrence.

 If you want to track the number of sessions in which the event
occurrence, set the value to Last Occurrence.

 If you want to track each time that the event occurred in a
session, set the value to Every Occurrence.

Value Type Step-based events can track numeric or text values or the count of
occurrences of the event.

120 IBM Tealeaf cxReveal: cxReveal User Manual




Value step:

Dashboards Active Ssarch  Analyze Configure Teslsal Help (UTC-D6)  ADMIN: Logout

Sumrch Online Halp

rsesslans[0].message. content.type Event Created: 02/23/2012 11:18:42 Updated: 02 F
Harms |.=_!-ss|cl'|5[l'.l] rmessage conbsxt fppe Evant mm
Crascriphion |."ssu:'-'|=-[l:l] rmassage context fppe Evant

m a m x Diefault

Ewaluate: | Every Step =] Tack:|Fst per Session =] Value Tepe: [ Count Only =

! for ¢ I
r;.is;.::ﬂ.?:!z:”ﬁ“n i Selected ¥alue Type: Count

If the Conditions are true, the following s recorded of it & configurad;

= Event occurrence

Figure 47. Creating a step-based event - Value step

Note: The value of step-based events can be specified like any other event.

Other steps: For step-based events, you can configure the other steps as you
would any other event.

Advanced Mode: To see the native JavaScript created for your step-based event,
click Advanced Mode.

Creating a dimension

After you create the step attribute, event, or both to track a value in a submitted
message, you can create a dimension to record values from the event or attribute
in the standard manner.

Note: Dimensions that are populated by step attributes or events can capture new
values from multiple steps in a hit.

In RTV

Creation of step attributes and events is not supported in RTV.

In request view, you can review the raw JSON messages in the [RequestBody]
section of the request.

You can use RTV to save test TLA sessions, which can be loaded into the Event
Tester to use as test data for step-based events.

In Event Tester

In the Event Tester, you can validate the triggering of step-based attributes and
events. Step attributes and the events that are triggered from them are displayed as
regular hit attributes and events in the test results.

Note: After you create step-based objects, it can take a few minutes before they are
available for selection in the Event Tester.

Indexing

Step-based event data is not indexed by default. You can, however, search for
events through BBR and RTV.
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It is possible to move data from one location in the request into another section
which is automatically indexed for search.

Note: If you must index some JSON-based session data for search, you must use a
privacy rule to insert the data into the [appdata] section. Creation of the rule
requires configuration of a regular expression to locate the data. Regular
expressions are considered an advanced configuration option, as if they are poorly
specified, they can significantly impact system performance.

* For more information about configuring regular expressions, contact Tealeaf
http:/ /support.tealeaf.com.

* Use of privacy rules against JSON message data is likely to be supported in a
later release.

Reference

Section
Description

"CX Browser Based Replay" in the IBM Tealeaf cxImpact User Manual
BBR documentation

"Browser Based Replay Interface" in the IBM Tealeaf cxImpact User Manual
How to use BBR, including how to access request view

"TEM Hit Attributes Tab" in the IBM Tealeaf Event Manager Manual
How to create hit attributes or step attributes in Event Manager

"TEM Events Tab" in the IBM Tealeaf Event Manager Manual
How to create events in Event Manager

"UI Capture for Ajax Guide" in the IBM Tealeaf UI Capture for Ajax Guide
Reference guide for the IBM Tealeaf CX UI Capture for AJAX solution

"Tealeaf Android Logging Framework Reference Guide" in the IBM Tealeaf
Android Logging Framework Reference Guide
Reference guide for the IBM Tealeaf CX Mobile Android Logging
Framework

"Tealeaf iOS Logging Framework Reference Guide" in the IBM Tealeaf iOS
Logging Framework Reference Guide
Reference guide for the Tealeaf IOS Logging Framework

"Event Tester" in the IBM Tealeaf Event Manager Manual
Portal-based Event Tester displays step-based attributes and events
transparently

"Searching Session Data" in the IBM Tealeaf cxImpact User Manual
Searching for sessions through the Portal

"RealiTea Viewer - Request View" in the IBM Tealeaf RealiTea Viewer User Manual
Request view page for RTV.

Note: You cannot create step attributes through RTV.

"RealiTea Viewer - Session Search and Subsearch" in the IBM Tealeaf RealiTea
Viewer User Manual
Searching for sessions through RTV

"Configuring CX Indexing" in the IBM Tealeaf CX Configuration Manual
How sessions are indexed and how data is added for indexing
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"Privacy Session Agent" in the IBM Tealeaf CX Configuration Manual
Session agent that is used to move content in the request

Chapter 6. cxImpact Browser Based Replay 123



124  IBM Tealeaf cxReveal: cxReveal User Manual



Chapter 7. IBM Tealeaf documentation and help

IBM Tealeaf provides documentation and help for users, developers, and
administrators.

Viewing product documentation
All IBM Tealeaf product documentation is available at the following website:
https:/ /tealeaf.support.ibmcloud.com/

Use the information in the following table to view the product documentation for
IBM Tealeaf:

Table 13. Getting help

To view... Do this...
Product documentation On the IBM Tealeaf portal, go to ? > Product
Documentation.

Help for a page on the IBM Tealeaf Portal On the IBM Tealeaf portal, go to ? > Help
for This Page.

Help for IBM Tealeaf CX PCA On the IBM Tealeaf CX PCA web interface,
select Guide to access the IBM Tealeaf CX
PCA Manual.

Available documents for IBM Tealeaf products

Use the following table to view a list of available documents for all IBM Tealeaf
products:

Table 14. Available documentation for IBM Tealeaf products

IBM Tealeaf products Available documents
IBM Tealeaf CX * IBM Tealeaf Customer Experience Overview
Guide

* IBM Tealeaf CX Client Framework Data
Integration Guide

* IBM Tealeaf CX Configuration Manual
* IBM Tealeaf CX Cookie Injector Manual
* IBM Tealeaf CX Databases Guide

* IBM Tealeaf CX Event Manager Manual
* IBM Tealeaf CX Glossary

* IBM Tealeaf CX Installation Manual

* IBM Tealeaf CX PCA Manual

* IBM Tealeaf CX PCA Release Notes
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Table 14. Available documentation for IBM Tealeaf products (continued)

IBM Tealeaf products

Available documents

IBM Tealeaf CX

* IBM Tealeaf CX RealiTea Viewer Client Side
Capture Manual

* IBM Tealeaf CX RealiTea Viewer User
Manual

* IBM Tealeaf CX Release Notes
* IBM Tealeaf CX Release Upgrade Manual

* IBM Tealeaf CX Support Troubleshooting
FAQ

* IBM Tealeaf CX Troubleshooting Guide
* IBM Tealeaf CX UI Capture j2 Guide
* IBM Tealeaf CX UI Capture j2 Release Notes

IBM Tealeaf cxImpact

* IBM Tealeaf cxImpact Administration Manual
* IBM Tealeaf cxImpact User Manual
* IBM Tealeaf cxImpact Reporting Guide

IBM Tealeaf cxConnect

* IBM Tealeaf cxConnect for Data Analysis
Administration Manual

* IBM Tealeaf cxConnect for Voice of Customer
Administration Manual

* IBM Tealeaf cxConnect for Web Analytics
Administration Manual
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Bay Area Lab

1001 E Hillsdale Boulevard
Foster City, California 94404
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."

Notices 129


http://www.ibm.com/legal/copytrade.shtml
http://www.ibm.com/legal/copytrade.shtml

130 IBM Tealeaf cxReveal: cxReveal User Manual






Printed in USA



	Contents
	cxReveal User Manual
	Chapter 1. cxReveal Overview
	Search
	Replay
	cxReveal Features
	Next Steps

	Chapter 2. cxReveal - Quick Start Guide
	Install
	Login
	Session Search
	Session Attribute Search

	cxReveal - Sessions List
	cxReveal - Replay
	BBR commands

	Reference

	Chapter 3. cxReveal Overview dashboard
	Using the Dashboard
	Usage Summary Tab
	Usage Metrics Summary - Today
	Usage Metrics by User - Today
	User Searches
	Search Effectiveness
	Sessions Replayed
	Replay Use
	User Inactivity for Annotations - Today

	Configuring the Dashboard

	Chapter 4. cxReveal - Searching for Sessions
	Selecting and modifying search options
	Search template
	Search template types
	Selecting a search template
	Session list template
	Configuring templates

	Other search criteria
	Search Range
	Specifying a search range

	Search scope
	Search options

	Managing searches
	Saving searches
	Opening searches

	Reference
	Building and submitting a search
	Search template
	Selecting dates
	Specifying a search
	Field Types
	Search Configuration Window
	Search Scope
	Field criteria

	Submitting a search
	Toolbar
	Reference
	Search Results
	Types of searches
	Session List
	Displayed Session Limits
	Session List Fields
	Session List Commands
	Session List Icons
	Exporting Search Results
	Session List Template selector

	Additional Search Results Information
	Search Server information
	Search query
	Search range


	Sub-Search

	Chapter 5. cxReveal - Searching Sessions by Session Attribute
	Overview of Session Attribute Search
	Differences between cxImpact Search and cxReveal Search

	Selecting cxReveal search templates
	Selecting a Session List Template

	Specifying Search Terms
	Available Dates
	cxReveal Comparison Operators
	Modify Search Options

	Running Searches
	Search results

	Chapter 6. cxImpact Browser Based Replay
	Overview
	Opening BBR
	For Active Sessions
	For Completed Sessions

	Replaying Sessions
	Replay View
	Replay Session
	Replaying sessions from mobile visitors
	Session Timeout

	Finding Pages
	Managing BBR Panes
	Searching Archived Sessions for Text
	Sharing Replays
	Sharing with Email
	Copy the session link

	Creating Event Data from BBR
	Configuration
	Configuring the Replay Server
	Configuring BBR replay rules

	Configuring Proxy
	ESI Tag Support

	Browser Based Replay Interface
	UI Components
	Toolbar
	Page List
	Refresh List (Active sessions only)
	Hide
	Overlays menu
	Annotations
	Start Replay
	Previous / Next
	Close Session

	Content Pane
	User Agent Information Bar

	Display
	Replay View
	Request View
	Response View
	Page Load Details

	Page Statistics
	Navigation Pane
	Navigation pane hierarchy
	Navigation pane columns
	Navigation pane tools
	Other panes
	Navigation context menu

	Events Pane
	Event Reports

	Form Fields Pane
	Form Fields menu

	Session Statistics

	Tracking Interactions through BBR
	Shadow Browsing Live Sessions
	Replay Highlighting
	Adding Annotations
	Availability of Annotations through Search
	Locating Annotations

	Finding Search Results in BBR
	BBR Replay of Client User Interface Events

	Sub-Search in BBR
	Searching for Sessions
	Defining a Sub-Search
	Executing the Search
	Available locations for Sub-Search
	Available operators
	Searching active sessions

	Filtered Results
	Navigation List toolbar
	Filtering the Navigation List
	Hit Details

	Sub-Search in RTV

	BBR Options
	Options Menu
	Options Sub-Menu
	Toggling Display of UI Events

	Merging Session Fragment Overrides
	Configuring BBR Replay Rules

	BBR Replay Rules
	Overview
	Required Access
	RTV

	Replay Rule Types
	Replay Rule Configuration through the Replay Server
	Selecting Replay Rules to Modify
	Editing replay rules
	Protocol
	Ignored URLs
	Highlight Only URLs
	Custom UI Event Actions
	Host/Port Remapping
	Response Modification
	White List Rules

	Replay Rule Configuration in BBR
	In Navigation List
	In Main Panel
	In Load Details

	Replay Rule Configuration in RTV
	Replay Rule Configuration File
	Special Rules


	Step-based eventing
	Overview
	Pre-requisites
	Limitations
	Technical definition
	Message types
	Example messages

	Step-based objects
	Default step objects
	Step trigger types
	Privacy

	Replay
	Navigable Pages List
	Viewing formatted JSON messages

	Creating Step-Based Event Objects
	Required access
	BBR step attribute context menu
	Creating a step attribute
	Creating a step event
	Creating a dimension
	In RTV
	In Event Tester

	Indexing
	Reference


	Chapter 7. IBM Tealeaf documentation and help
	Notices
	Trademarks
	Privacy Policy Considerations


